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CHAPTER 1

Getting started
If you haven’t installed your new software, begin by reading some information on installation 
and other preliminaries. Before you begin working with your software, take a few moments to 
read an overview of the many resources available to you. You have access to instructional 
videos, plug-ins, templates, user communities, seminars, tutorials, RSS feeds, and much more 
for various Adobe products.

Installation

Installing the software
To review complete system requirements and recommendations for your Adobe® software, 
refer to the ReadMe file on the installation disc.

1. Quit any other Adobe applications running on your computer.

2. Insert the installation disc into your DVD drive, and follow the on-screen instructions.

Choosing PAL or NTSC video format
When you run the program for the first time, you select either NTSC or PAL as the default 
video format for new sessions. PAL and NTSC are two common standards for standard-
definition broadcast television, each used in different regions of the world. The format that 
you choose affects the options that are available on the Output tab.

N
O

T
E

Be sure to first install and activate at least one component of Adobe Creative Suite 3 
Production Premium or Master Collection. Adobe Ultra CS3 will only start on a computer 
on which Adobe Creative Suite 3 Production Premium or Master Collection has been 
activated. 

N
O

T
E

To change the default video format for new sessions, select Tools > Application Settings.
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ReadMe
The ReadMe file on the installation disc is also copied to the application folder during 
product installation. Open the file to read important information about the following topics:

■ System requirements
■ Installation (including uninstalling the software)

Troubleshooting
Customer support
Legal notices

Resources

Adobe Help resources
Documentation for your Adobe software is available in a variety of formats.

In-product and LiveDocs Help
In-product Help provides access to all documentation and instructional content available at 
the time that the software ships. You can access in-product Help by choosing Help > Adobe 
Ultra Help, or by pressing F1.

LiveDocs Help includes all the content from in-product Help, plus updates and links to 
additional instructional content available on the web. For some products, you can also add 
comments to the topics in LiveDocs Help. Find LiveDocs Help for your product in the Adobe 
Help Resource Center, at www.adobe.com/go/documentation.

Most versions of in-product and LiveDocs Help let you search across the Help systems of 
multiple products. Topics may also contain links to relevant content on the web or to topics 
in the Help of another product. 

Think of Help, both in the product and on the web, as a hub for accessing additional content 
and communities of users. The most complete and up-to-date version of Help is always on the 
web.

PDF documentation
The contents of in-product Help are also available as a PDF that is optimized for printing. 
Other documents, such as installation guides and white papers, may also be provided as 
PDFs. 
10 Getting started
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All PDF documentation is available through the Adobe Help Resource Center, at 
www.adobe.com/go/documentation. To see the PDF documentation included with your 
software, look in the Documents folder on the installation or content disc.

Printed documentation
Printed editions of the contents of in-product Help are available for purchase in the Adobe 
Store, at www.adobe.com/go/store. You can also find books published by Adobe publishing 
partners in the Adobe Store.

A printed workflow guide is included with all Adobe Creative Suite® 3 products, and some 
stand-alone Adobe products include a printed getting started guide.

Adobe Video Workshop
The Adobe Creative Suite 3 Video Workshop offers over 200 training videos covering a wide 
range of subjects for print, web, and video professionals.

You can use the Adobe Video Workshop to learn about any Creative Suite 3 product. Many 
videos show you how to use Adobe applications together.

When you start the Adobe Video Workshop, you choose the products you want to learn about 
and the subjects you want to view. You can see details about each video to focus and direct 
your learning.

Community of presenters
With this release, Adobe Systems invited the community of its users to share their expertise 
and insights. Adobe and Lynda.com present tutorials, tips, and tricks from leading designers 
and developers such as Joseph Lowery, Katrin Eismann, and Chris Georgenes. You can see and 
hear Adobe experts such as Lynn Grillo, Greg Rewis, and Russell Brown. In all, over 30 
product experts share their knowledge.

Tutorials and source files
The Adobe Video Workshop includes training for novices and experienced users. You’ll also 
find videos on new features and key techniques. Each video covers a single subject and 
typically runs about 3-5 minutes. Most videos come with an illustrated tutorial and source 
files, so you can print detailed steps and try the tutorial on your own.
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Using Adobe Video Workshop
You can access Adobe Video Workshop using the DVD included with your Creative Suite 3 
product. It’s also available online at www.adobe.com/go/learn_videotutorials. Adobe will 
regularly add new videos to the online Video Workshop, so check in to see what’s new.

Extras
You have access to a wide variety of resources that will help you make the most of your Adobe 
software. Some of these resources are installed on your computer during the setup process; 
additional helpful samples and documents are included on the installation or content disc. 
Other useful extras are also offered online by the Adobe Exchange community, at 
www.adobe.com/go/exchange.

During software installation, a number of resources are placed in the application folder on 
your computer: [startup drive]\Program Files\Adobe\Adobe Ultra CS3.

Ultra tutorials are available on the Adobe website at www.adobe.com/support/ultra. Click the 
Tutorials link to see the tutorials. The video files referred to in the tutorials are located in the 
folders in the Browse tab in Ultra.

Adobe Design Center
Adobe Design Center offers articles, inspiration, and instruction from industry experts, top 
designers, and Adobe publishing partners. New content is added monthly.

You can find hundreds of tutorials for design products and learn tips and techniques through 
videos, HTML tutorials, and sample book chapters.

New ideas are the heart of Think Tank, Dialog Box, and Gallery:

Think Tank articles consider how today’s designers engage with technology and what their 
experiences mean for design, design tools, and society.
In Dialog Box, experts share new ideas in motion graphics and digital design.
The Gallery showcases how artists communicate design in motion.

Visit Adobe Design Center at www.adobe.com/designcenter.

Adobe Developer Center
Adobe Developer Center provides samples, tutorials, articles, and community resources for 
developers who build rich Internet applications, websites, content for mobile devices, and 
other projects using various Adobe products. The Developer Center also contains resources 
for developers who develop plug-ins for Adobe products.
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In addition to sample code and tutorials, you'll find RSS feeds, online seminars, SDKs, 
scripting guides, and other technical resources.

Visit Adobe Developer Center at www.adobe.com/go/developer.

Customer support
Visit the Adobe Support website, at www.adobe.com/support, to find troubleshooting 
information for your product and to learn about free and paid technical support options. 
Follow the Training link for access to Adobe Press books, a variety of training resources, 
Adobe software certification programs, and more.

Downloads
Visit www.adobe.com/go/downloads to find free updates, tryouts, and other useful software. 
In addition, the Adobe Store (at www.adobe.com/go/store) provides access to thousands of 
plug-ins from third-party developers, helping you to automate tasks, customize workflows, 
create specialized professional effects, and more.

Adobe Labs
Adobe Labs gives you the opportunity to experience and evaluate new and emerging 
technologies and products from Adobe.

At Adobe Labs, you have access to resources such as these:

Prerelease software and technologies
Code samples and best practices to accelerate your learning
Early versions of product and technical documentation
Forums, wiki-based content, and other collaborative resources to help you interact with 
like-minded designers and developers

Adobe Labs fosters a collaborative software development process. In this environment, 
customers quickly become productive with new products and technologies. Adobe Labs is also 
a forum for early feedback, which the Adobe development teams use to create software that 
meets the needs and expectations of the community. 

Visit Adobe Labs at www.adobe.com/go/labs.
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User communities
User communities feature forums, blogs, and other avenues for users to share technologies, 
tools, and information. You can ask questions and find out how others are getting the most 
out of their software. User-to-user forums are available in English, French, German, and 
Japanese; blogs are posted in a wide range of languages.

To participate in forums or blogs, visit www.adobe.com/communities.

Essential features

Get superior keying results even from marginal sources.

Using Ultra Vector Keying™ technology, shots that used to be difficult to key—uneven 
lighting, wrinkled backgrounds, and frizzy hair—can be keyed in minutes. Ultra will even 
preserve the shadows of your subject and achieve complex keys with scene elements such as 
smoke, liquids, and transparent objects with minimal effort. 

One-click keying

Ultra offers an extraordinary one-click keying feature for faster keying. Advanced controls, 
such as spill suppression, color restoration, and edge softening, can also be applied to fine-
tune composites. 

Sophisticated virtual sets made simple

Master Sets Libraries add high-end virtual set systems to Ultra. When used in conjunction 
with Ultra, these libraries can save you time and money by eliminating the need to rent 
specialized motion tracking cameras and 3D graphics workstations. Master Sets Libraries 
simulate conventional motion tracking by using the Ultra VirtualTrak™ system, which creates 
virtual camera moves from stationary camera shots and inserts video reflections into virtual 
scenes.

Broadcast quality using DV/HDV/HD

Ultra can use 16:9 widescreen and anamorphic widescreen sources, and it delivers excellent 
results from the reduced color bandwidth of DV video sources. Ultra also supports HD and 
HDV frame dimensions, including 1080i, 1080p, and 720p, with support for a variety of 
standard frame rates, including 24 fps.
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High-speed GPU keying

Ultra allows users with newer graphics cards (GeForce 5700 and Radeon 9600 or better for 
standard-definition video; GeForce 6600 and Radeon 9800 or better for high-definition 
video) to dramatically increase rendering speeds by shifting processing to the graphics 
processing unit (GPU). Using GPU-based processing, Ultra can typically perform vector 
keying in near-real time at HD resolution (depending on system configuration and file types).

High-resolution keying with standard-definition cameras

Ultra offers a Plus-90 mode to allow standard-definition cameras to generate footage for use 
in high-definition scenes. Video frames are wider than they are tall, yet human subjects are 
taller than they are wide. To make the optimum use of the greatest number of pixels for 
shooting a subject, you can rotate your camera 90 degrees, using the longer axis of the frame 
as the new vertical axis. This provides an additional 33% of vertical resolution when using a 
video format with a 4:3 frame aspect ratio, and an additional 78% of vertical resolution when 
using a video format with a 16:9 frame aspect ratio.

Virtual shadows and reflections

You can use Ultra to insert virtual shadows into a scene. You can then adjust the shadow's size, 
perspective, and transparency. When using photographic or rendered backgrounds, you can 
insert virtual reflections displaying an inverted image of the keyed subject.

Create custom virtual environments

Add your own backgrounds, B sources, and semi-transparent foreground images to create 
your own virtual environments, complete with multiple-point pans and zooms. Large, high-
definition custom background images can be explored with complex camera moves.

Support for high-resolution stills

Ultra offers support for high-resolution stills up to 4096x4096 pixels, allowing digital images 
to be used as high-definition input sources and backgrounds. With image support for BMP, 
JPG, PNG, TIFF, TGA, and PPM files, users can export high-resolution keyed stills for 
further editing or output to print or the web.
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Extensive input and output

Video formats supported for input include AVI, QuickTime, MPEG, DV, and any format for 
which you have a compatible codec installed. The Invert Alpha option inverts alpha channels 
for compatibility with non-linear editing systems that use film alpha (interpret an alpha 
channel value of 0 as complete opacity). Output files can be uncompressed AVI, DV, or 
QuickTime. AVI and QuickTime files can be output using 24 bits per pixel or 32 bits per 
pixel (with an 8-bit alpha channel). Output files with alpha channels can be used directly by 
other programs, such as Adobe After Effects, for further compositing.
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CHAPTER 2

Quick-start session
Step-by-step workflow
The following is an overview of the general workflow for creating a session, compositing, and 
exporting a movie with Adobe® Ultra® CS3.

Create a session with the appropriate frame aspect ratio: Choose File > New > New 4:3 
Session or File > New > New 16:9 Session. (See “Creating and managing Ultra sessions” 
on page 55.)

Assign a virtual set. (See “Assigning content to layers” on page 63.)

3. Assign a source to each layer. (See “Assigning content to layers” on page 63.)

4. Key the input clip. (See “Setting the key” on page 76.)

5. Trim the video clips to the desired length, and specify whether each clip will loop. (See 
“Cropping and spot masking the source clip” on page 83.)

6. Specify the scale, position, and orientation for each layer plane. Note that some layers in 
virtual sets may be locked, so you can’t change them. It is best to set up the scale and 
position of the input clip and other layers at the beginning of the session. (See “Setting the 
size, position, and orientation of a layer plane” on page 91.)

7. Position each input source on its layer plane. Use the Input Offset controls, which are at 
the center of the Input tab, to move and scale the active layer within its layer plane. (See 
“Moving and scaling an input within the layer plane: Input Offset controls” on page 95.)

8. Program the virtual camera moves and panning and zooming effects. (See “Panning and 
zooming” on page 99.)

9. Modify the video and audio as needed.

N
O

T
E

Steps 1, 4, and 10 are required.
Step 3 is required for the source input layer; other layers are optional.
Steps 5 through 9 may be optional, depending on the virtual set and sources that you 
use and what you’re trying to accomplish in the scene.
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■ Add virtual shadows or reflections. (See “Adding shadows and reflections” 
on page 111.)

■ Correct color. (See “Correcting colors” on page 108.)
■ Defocus the sources. (See “Defocusing a source” on page 119.)
■ Adjust the audio volume of the clips. (See “Adjusting the volume of a video clip” 

on page 107.)
10. Export the finished movie. (See “Saving the finished video” on page 119.)

Tutorial
The following is a step-by-step example of a simple NTSC session that uses NTSC sample 
files included with Ultra.

1. Start Ultra.

2. Drag a background from the Animations folder on the Backgrounds tab onto the 
Background thumbnail.

3. On the Browse tab, double-click the NTSC Sample Clips folder to open it. Drag the 
Hands Apart (Wedding) clip onto the Input Clip thumbnail.

4. Click the Set Key button on the Keyer tab. If the controls on the Keyer tab are disabled, 
click Input Clip thumbnail.

5. Drag the slider under the Output Preview Monitor to the time of 1 seconds (00:00:01.00), 
or enter this timecode in the timecode text box. A video frame showing two hands appears 
on the Output Preview Monitor.

6. On the Input tab, click the Set button to the right of the In Point text box. This makes it 
so that the first frame to appear in the movie is the frame at the time of 1 second in the 
input clip.

7. Move the Transparency slider on the Keyer tab to the left to 0.350, or type that value in 
the adjacent text box. The two hands become opaque.

N
O

T
E

The first frame in this clip shows only the greenscreen background. The method 
described in this tutorial only works for clips that have at least one frame that is a shot 
of only the background color screen.

N
O

T
E

The Hands Apart clip has a well-lit, even background that can be keyed out well with 
only this one adjustment. Some backgrounds require more manual fine-tuning to 
achieve a clean, convincing key. For more information, see “Fine-tuning the Keyer 
settings” on page 84.
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8. (Optional) To view the resulting composited video, click the Play button under the Output 
Preview Monitor.

9. In the Output tab, choose DirectShow (.avi) from the Format menu, and choose MJPEG 
Compressor.

10. Make sure that the Folder that you are exporting to is set to \My Documents\Adobe Ultra 
CS3\My Output Clips.

11. (Optional) Change the name of the file in the File Name field.

12. Click Save Output. Ultra renders the movie.

13. To view the movie that you’ve just created, right-click the thumbnail image for the new 
video file on the Output Clips tab, and choose Play. If you do not see your video in the 
Output Clips tab, click the Home button in the navigation bar.
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CHAPTER 3

Product overview
Overview
Adobe® Ultra® CS3 is a stand-alone keying and compositing application designed to use many 
kinds of video sources. The keying process starts with loading a virtual set, video clips, or 
both. You then calibrate the keyer, change any settings as needed, and record the output to a 
video file for use in an editing application, such as Adobe Premiere Pro or Adobe After 
Effects. Ultra is compatible with many standard video formats and has been fine-tuned to 
provide high-quality output and smooth performance, even with DV clips. You can 
immediately see any changes to the keyer quality settings.

Ultra exceeds other tools in many ways. One of the most noteworthy and powerful ways is 
that Adobe offers a wide range of virtual sets that provide background and, in many cases, 
foreground elements for video clips. Virtual sets come in collections known as master sets that 
have a variety of camera angles for the same virtual 3D environment. Available in packages 
known as Master Sets Libraries, most master sets have at least one set with virtual camera 
motions that use the Adobe VirtualTrak camera tracking system. You can use your own 
videos, digital images, and graphics as backgrounds, foregrounds, and insets for composited 
movies created in Ultra.

Ultra contains advanced features and innovations that separate it from conventional chroma 
keyers (color keyers).

With Live Preview, you can adjust the lighting, camera placement, angle, and zoom to fit 
the set that you are using before you shoot the source footage.
Dynamic controls let you adjust the size, position, and orientation of the source video and 
other layers in the virtual set.
Up to four independent overlays let you easily customize virtual sets and add dimension 
to composited movies.
The pan and zoom features let you add virtual camera moves and zooms to scenes.
The GPU Boost feature substantially speeds up keying and compositing.
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Layers, inputs, and virtual sets

A) Composited output  B) Overlay  C) Input clip (subject)  D) Background  E) Source B (inset) 

Input name Definition

Virtual set All Ultra sessions have a virtual set. A virtual set can be as simple as one of 
the Simple Keyed virtual sets—which are empty sets—or as complex as one of 
the sets in the Master Sets Libraries. Some virtual sets have transparent 
(alpha) regions for insets, with a predefined scale, position, and orientation. 
Some virtual sets also have foreground elements such as doors, desks, and 
podiums. To customize the colors or otherwise manipulate the layers of a 
virtual set, you must switch from the standard User-Defined Inputs mode to 
the Pre-Defined Inputs mode (View > Displayed Inputs > Pre-Defined). For 
more information about virtual sets, see “Virtual sets” on page 24.
Ultra comes with a few included virtual sets, including one of the Master Sets 
Libraries, MSL1. Adobe sells additional collections of virtual sets as Master 
Sets Libraries. You can also create your own custom virtual sets.
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Background This is typically the main layer behind the subject, filling the entire frame. The 
background can have one or more alpha regions that show through to insets 
behind it. 
You usually set backgrounds only in sessions that use one of the basic virtual 
sets. In most cases, advanced virtual sets define their own backgrounds; 
virtual sets that show the input clip as an inset are the only ones that let you 
define a background. The virtual set defines the foreground around the inset, 
but the Background assignment defines the background for the input clip. 
For example, in the Museum Painting Center (MSL1) virtual set, the  icon 
represents the input clip. Some shots in the Master Sets Libraries are tightly 
framed shots of one of the virtual monitors in the set. In these shots, the input 
clip and the background are both scaled inside the monitor frame, with the 
background behind the input clip.
By adjusting the scale, position, and orientation of the Background layer, you 
can essentially turn it into a midground layer that sits behind the subject, but 
does not fill the frame. In this case, you typically use an inset (Source B) to fill 
the frame. For an example of this type of a session, see Ultra Tutorial #7 on 
the Ultra support web page, www.adobe.com/support/ultra.

Input Clip or 
Live Preview

This is the main video source shot against a greenscreen or bluescreen, 
which you key and composite with the other layers. It sits behind the overlays 
but in front of all of the other layers, and is sometimes referred to as the 
subject. When the subject is a person, the term talent is sometimes used.

Source B, 
Source C, and 
so on

The layers identified as Source B, Source C, and so on (also called insets) sit 
behind the background. In most cases, they appear as insets that show 
through transparent regions in the background. The number of insets is 
defined by the virtual set. Each inset is a separate layer.

Overlay 1, 
Overlay 2, 
Overlay 3, and 
Overlay 4

Overlays sit in front of everything else in the composited scene. They almost 
always have an alpha channel that defines transparent and semi-transparent 
areas so that you can see through to the underlying layers, but you can 
achieve the same result in some situations by scaling the image down to an 
appropriate size. You can add up to four overlays, each of which is a separate 
layer. For more information, see “Adding overlay layers” on page 66.
The following are some examples:
• Props that add dimension to the scene
• Doors, pillars, and so on, from behind which the subject enters
• Titles, lower thirds, and captions
• Watermarks and semitransparent logos, such as those that often appear in 

a lower corner of the frame in a television program

Input name Definition
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Active layer
To manipulate a layer by using any of the tabs, the layer must be the active layer. To make a 
layer the active layer, either click its thumbnail or select it from the list below the Input 
Preview Monitor. The active layer is displayed in the Input Preview Monitor, and the light 
next to the layer’s thumbnail image is bright (lit) green .

A) Active layer  B) Source for active layer  C) Assign new source to active layer  D) List for choosing 
active layer

The Overlay option appears in the list below the Input Preview Monitor only if an overlay 
source is assigned. From this list, you can also select Live Preview, which is intended only for 
setting up a shot and confirming that it will key well. For more information, see “Shooting 
video for Ultra” on page 57. 

The Browse button provides one of several ways to assign a source to the active layer. For 
more information, see “Assigning source content to a layer” on page 63. To determine which 
folder a source came from, click the Browse button to open a dialog box that shows the 
source’s current location.

To make a particular inset or overlay the active layer when two or more of them are in a 
session, click the field above the thumbnail, and select the layer from the list. If you use the 
list below the Input Preview Monitor to select Inset or Overlay, the currently selected inset or 
overlay layer becomes the active layer.

Assigning a source to a layer by dragging the source to the layer thumbnail does not make that 
layer the active layer.

Virtual sets
Virtual sets range from simple to complex. Virtual sets in the Basic folder are the simplest; 
they are essentially blank sets for which you assign the background and up to four overlays 
and four inset sources. Only the insets in these virtual sets have a predefined size and position, 
and you’ll probably want to customize those settings. 
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The “Corner Office Monitor to Talent - Pause at Beginning (Trak) Sitting” virtual set is one 
of the most complex sets in all of the Master Sets Libraries. This virtual set starts with a pause 
point on an inset, and then performs a virtual camera move to the subject, which is 
composited between two predefined layers: a desk in front and a wall of windows behind 
looking out on a cityscape.

A Master Set is a collection of virtual sets with a unified appearance and layout, each of which 
is essentially a different perspective on the same 3D environment. A virtual set file from one 
of the Master Sets Libraries (MSLs) defines a group of inputs and their positions, some of 
which are predefined and others of which you assign. Designations for insets are consistent 
throughout a Master Set. For example, Source D in one set is in the same relative position in 
any other set from the same Master Set that uses a Source D. That’s why the insets in some 
sets do not start at Source B. 

The virtual sets provided with Ultra have a file extension of .mfx.

Each virtual set has a native frame aspect ratio. In most cases, you should match the frame 
aspect ratio of the virtual set to the frame aspect ratio of the session as set on the Output tab. 
However, Ultra lets you mix them if that suits your purposes. You will find 16:9 sets in the 
Basic folder on the Virtual Sets tab.

The name of a virtual set provided as a part of the Master Sets conveys the following 
information:

The first word or two indicates the master set to which the virtual set belongs.
This is usually followed by a description of the shot, typically the camera number or 
position. VirtualTrak sets are an exception, with names that typically describe the camera 
movement (for example, “Monitor to Stage” or “Dolly to Bookcase”).

This is followed by text that indicates if there’s a foreground element or if the VirtualTrak 
shot includes a pause point. For more information, see “Setting a pause point for a 
VirtualTrak effect” on page 107.

N
O

T
E

With the exception of those sets labeled 16x9, Ultra Master Sets use a 4:3 frame aspect 
ratio. For instructions on converting this aspect ratio for a widescreen session, see 
Tutorial #15 “Using 4:3 sets in a 16:9 project” on the Ultra support website, 
www.adobe.com/support/ultra.

N
O
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E

VirtualTrak is a proprietary feature included in some of the Ultra Master Sets Libraries. It 
provides virtual camera movement with a more realistic tracking motion than standard 
pan and zoom. This movement is not reproducible in custom-built virtual sets. Ultra 
virtual sets with “Trak” in the title have VirtualTrak functionality included.
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This is followed by the type of framing enclosed with parentheses: Tight, Medium, Wide, 
or Sitting. VirtualTrak effects are designated as “Trak”. For these, you should preview the 
tracking shot to determine its final framing. Virtual set names that have nothing in 
parentheses display the input clip (Source A) in an inset. In this case, any framing will 
work.

A) Tight: Designed for the subject to be framed from the chest up.  B) Medium: Designed for 
the subject to be framed from the waist up.  C) Wide: Designed for the subject to be standing, 
visible from head to foot, and possibly scaled down.

For instructions on assembling a set using your own graphics, see “Creating elements for a set 
or individual layers” on page 68.

For more information, see the following sections:

“Input area and Input Preview Monitor” on page 28
“Creating and assigning sources and virtual sets” on page 57
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User interface
This section provides an orientation to the controls and displays that you use in Adobe® 
Ultra®.

A) Input area  B) Output area  C) Controls area

The Ultra interface consists of the following main regions:

The input area in the upper left consists of the Input Preview Monitor and several 
controls that you can use to assign sources, select the active layer, preview the source 
content, and select tools for setting the key and panning and zooming. For more 
information, see “Input area and Input Preview Monitor” on page 28.
The output area in the upper right contains the Output Preview Monitor, which displays 
the composited image, and controls for previewing the session. For more information, see 
“Output Preview Monitor and previewing the output” on page 31.
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The set of tabs along the bottom of the window serve many purposes. The six tabs on the 
left are for setting the key and making all of the necessary adjustments to the layers and 
sources. Near the center, the Output tab is for setting session properties and rendering the 
final composited movie. The tabs on the right provide access to libraries of virtual sets, 
sessions, and output movies and graphics. For more information, see “Tabs” on page 35.

Input area and Input Preview Monitor

The input area consists of the following displays and controls related to the active layer and its 
assigned source:

The layer thumbnails on the right are for choosing and showing which layer is the active 
layer.
The Input Preview Monitor displays the source that’s assigned to the active layer.
The buttons below the Input Preview Monitor are for selecting the tools to change the 
view, set keying points, and paint a mask.
The transport controls and slider are for previewing the active layer’s source.
The two fields below the slider are for selecting the active layer, assigning a source to it, 
and displaying the name of the layer and the source.

The Input Preview Monitor displays the source assigned to the active layer. This monitor 
shows the results of keyer and color correction settings and any masking if the input clip is 
selected. The settings for the size, position, and orientation for the layer plane or the source 
do not affect what is shown in the Input Preview Monitor.
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You can view the Input Monitor with its original, unkeyed background or with the 
checkerboard alpha background. To switch between these display modes, choose View > 
Input Clip Preview Background, and then choose either Original Source or Alpha Grid.

A white rectangle in the Input Preview Monitor and Output Preview Monitor identifies the 
action-safe area. Content outside this area may not be visible if the output movie is viewed on 
a television. To show or hide the action-safe overlay, choose View > Safe Area Overlay or press 
Alt+S.

For more information, see “Magnifying and repositioning the view in the monitors” 
on page 33.

Layer thumbnails
The small images to the right of the Input Preview Monitor are thumbnail images of the 
sources assigned to each layer. Clicking a thumbnail for a layer makes it the active layer. If 
there are multiple insets or overlay layers, you can select among them by using the list above 
the thumbnail. You can assign a source to a layer by dragging the source to the appropriate 
thumbnail image.

Thumbnail graphics: If no image icon is present, you will see the following symbols 
representing the available actions for the current set:

LED icons next to the thumbnails: The status of each layer is indicated by a light next to the 
layer’s thumbnail image.

Bright (lit) green : Layer is the active layer.
Dark (unlit) green : Layer has content assigned, but is not the active layer.
Yellow : Layer is optional and has no source content assigned.
Red : Layer is not used in this session.

This layer requires a source for the current set, but none is currently assigned.

This layer is available for the current set, but no source is currently assigned.

No source can be assigned with the current set.
User interface 29



The Background and Input Clip thumbnails have right-click menus with which you can 
switch from a given source to a white, black, or checkerboard image and back again. For the 
Background thumbnail, these images can help you analyze the quality of the key for the input 
clip. For the Input Clip thumbnail itself, you may want to switch to one of these alternate 
sources to see the size, position, and orientation of the input clip’s plane. However, assigning 
a new source in this fashion can cause you to lose a custom mask that you’ve painted.

For more information, see the following sections:

“Layers, inputs, and virtual sets” on page 22
“Assigning content to layers” on page 63

Controls under the Input Preview Monitor

A) Current time  B) Transport controls  C) Preview slider  D) List for selecting which layer is the 
active layer  E) Source for active layer  F) Select new source for active layer

Current time: If the source assigned to the active layer is a video clip, then this field displays 
the current time in the video clip. This is an interactive field. You can type a timecode to 
jump to a specific time in the clip.

Transport controls: Standard controls for playing and navigating video clips.

Preview slider: This is the slider for manually previewing (scrubbing) video clips.

Active Layer list: Shows which layer is the active layer. To select a different layer to be the 
active layer, either select it from this list or click its thumbnail.

Current source: Shows the name of the file assigned as the source for the active layer. To 
change the source, type the name of another file in this field.

Browse button: Opens the standard Windows dialog box for selecting a new source. You can 
also use this button to check the path of the current source.

Tool buttons
Click the buttons along the bottom of the Input Preview Monitor to activate the following 
tools.
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Key point (input clip only):  Clicking with this tool in the Input Preview Monitor sets a 
key point for either the One Color Pickup or Color Spread keying method. For more 
information, see “Single Key Point Method (One Color Pickup)” on page 79 or “Multiple 
Key Points Method (Color Spread)” on page 80. To delete the last key point that you set, 
press Ctrl+Z. To delete all of the key points that you set, click the Clear Points button on the 
Keyer tab.

Painting a mask (input clip only): For more information, see “Painting a mask” on page 84.

Pan and zoom: For more information, see “Magnifying and repositioning the view in the 
monitors” on page 33.

Output Preview Monitor and previewing the output
The Output Preview Monitor displays a preview of the session as the output movie will 
appear if you save it with the current settings. If the input clip is keyed and all of the other 
sources are assigned, then the Output Preview Monitor displays the fully composited session.

The frame aspect ratio of this monitor changes based on whether you select 4:3 or 16:9 on the 
Output tab.

Paint Mask: Drag with this tool in the Input Preview Monitor to create a transparent 
region. Zooming in decreases the size of the paint brush.

Mask Eraser: Drag with this tool in the Input Preview Monitor to erase a transparent 
region.
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A white rectangle in the Input Preview Monitor and Output Preview Monitor identifies the 
action-safe area. Content outside this area may not be visible if the output movie is viewed on 
a television. To show or hide the action-safe overlay, choose View > Safe Area Overlay or press 
Alt+S.

The Output Preview Monitor scales when you change the size of the Ultra application 
window. The Resolution setting on the Output tab controls the monitor’s resolution, or 
image quality. If the Resolution setting is lower than the actual size of the Output Preview 
Monitor, then you may see some pixelation that will not be in the final output movie, because 
the monitor is enlarging the image beyond the resolution to which you will be exporting. If 
the Resolution setting is higher than the actual size of the Output Preview Monitor, then the 
image is scaled down to fit in the monitor.

Use the standard set of transport controls below the Output Preview Monitor to navigate and 
play the session. You can also drag the slider bar to preview the session. The timecode field in 
the lower-left corner displays the current position in the session. This is an interactive field, so 
you can enter a timecode to jump to a specific time.

To toggle playing the session in a continuous loop, choose Play > Loop Mode or press F9.

To preview the output in full-screen, press Alt+Enter. This shortcut also returns to the regular 
interface.

Panning and zooming in the Output Preview Monitor is one of several ways to control the 
scale of images or the framing of what’s displayed. For more information, see “Magnifying and 
repositioning the view in the monitors” on page 33. 

If what you see in the Output Preview Monitor is not what you expect, and the Output 
Preview Monitor is set to full-frame view, then check the settings described in the following 
table.
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Magnifying and repositioning the view in the monitors
You can pan and zoom within the Input Preview Monitor and Output Preview Monitor to 
move to and magnify any area of interest.

To zoom, position the pointer over the monitor and roll the mouse wheel; or drag 
vertically in the monitor with the Zoom tool .
To zoom in the Output Preview Monitor, use the Magnify Preview slider on the Keyer 
tab.
To pan around a zoomed image, drag in the monitor with the Move tool . With the 
Pan tool or Zoom tool selected, you can hold down the Ctrl key to temporarily activate 
the other tool.
To return a monitor to full-frame view, click the  button beneath the monitor.

Control Tab Description

Position In Scene Scene Controls the size and position of the layer plane. 
See “Changing the position and scale of a layer 
plane” on page 92.

Orientation In Scene Scene Controls the perspective of the layer plane in all 
three axes. See “Changing the orientation of a 
layer plane” on page 93.

Size in Scene Scene Controls the scale of the layer plane independent 
of the Z setting in the Position In Scene control. 
This option lets you scale the layer plane of the 
input clip in sets that lock the other Scene controls. 
See “Rescaling the input clip’s layer plane in a 
virtual set” on page 92.

Input Offset Input Controls the size and position of the image on the 
layer plane. See “Moving and scaling an input 
within the layer plane: Input Offset controls” 
on page 95.

Pan and Zoom Pan and 
Zoom

Controls the region of the composited scene that 
will be shown for every frame of the exported 
output movie. See “Panning and zooming” 
on page 99.

N
O

T
E

Reverting to the full-frame view when you’re finished examining part of the image with 
the Output Preview Monitor zoomed can help you avoid problems. These problems may 
result because you changed the size, position, and orientation of one or more layers, but 
forgot that the Output Preview Monitor was zoomed.
User interface 33



Sliders

Ultra provides many sliders. Dragging is the main method for adjusting a slider, but it isn’t 
the only method. After you click a slider, you can also make fine adjustments by using the 
Right Arrow and Left Arrow keys. You can also enter values in the text boxes associated with 
some sliders.

Grid controls
Ultra provides several grid controls that you use by dragging vertically or horizontally, 
sometimes while you hold the Shift or Ctrl key. For fine control, hold down the Alt key while 
dragging; this refines the response by a factor of 10. As with sliders, you can enter a value in 
the numeric fields next to a grid control. 

For more information about individual controls, see the following sections:

“Setting the size, position, and orientation of a layer plane” on page 91
“Moving and scaling an input within the layer plane: Input Offset controls” on page 95
“Panning and zooming” on page 99

Timecode fields
Trimming a video clip and specifying its start time, defining pause points, and programming 
pan and zoom moves all involve setting timepoints based on the time either in a given video 
clip or in the overall session. You can set these timepoints by dragging the preview slider to 
the desired frame and clicking the Set button for the appropriate control, or by typing the 
value in the text box. If you enter a timecode manually, do not click the Set button, because 
that overwrites the value you typed with the current timecode for the active layer.
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Timecode in Ultra is relative to the beginning of the clip or the overall session. The timecode 
of the first frame of an untrimmed clip or scene is always 00:00:00.00.

Tabs
This section describes the tabs that appear below the Input Preview Monitor and Output 
Preview Monitor.

Keyer tab
The Keyer tab consists of the following controls. The Matte Generation, Color Control, and 
Post-Processing controls are used to fine-tune the key. For more information, see “Fine-tuning 
the Keyer settings” on page 84.

General controls

Enable: Turns the keyer on and off. The keyer is automatically enabled when you click the 
Set Key or Apply Points button. If you want to see the unkeyed input clip in the scene, you 
can deselect Enable to disable the keyer without losing any of the settings. For more 
information, see “Setting the key” on page 76.

GPU Boost: When enabled, Ultra uses the graphics processing unit (GPU) for some keying 
functions, which reduces the load on the CPU and substantially accelerates previewing and 
exporting a keyed session. For more information, see “Keying methods” on page 76.

Set Key: Clicking this button when nothing but the keying background is visible in the Input 
Preview Monitor calibrates the keyer using the Set Key method. If you set any points in the 
Input Preview Monitor, then this button changes to the Apply Points button. For more 
information, see “Set Key” on page 78.

Apply Points: If you set any key points in the Input Preview Monitor, then clicking this 
button uses those points to set the key. For more information, see “Setting Key Points (Apply 
Points Method)” on page 79.

Clear Points: This button deletes all key points that were set in the Input Preview Monitor, 
regardless of whether you’ve applied them yet. This does not clear the key so that the 
background becomes visible again; the only way to accomplish that after a clip is keyed is to 
disable the keyer by deselecting Enable. For more information, see “Multiple Key Points 
Method (Color Spread)” on page 80.
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Load: Loads saved settings, letting you transfer keyer settings from one session to another 
with clips using similar lighting.

Save: Saves the current settings, but not the key points. This lets you save your work so that 
you can further experiment, or transfer keyer settings from one session to another with clips 
using similar lighting.

Magnify Preview: This slider is one method for zooming on the Output Preview Monitor. 
For more information, see “Magnifying and repositioning the view in the monitors” 
on page 33.

Matte Generation area

Start Threshold: Changes the range of colors that are accepted as transparent. You typically 
use this control if uneven lighting creates noise in the key.

Transparency: Controls the overall transparency of the source video. This control increases 
the range of transparency of the reference key color background, starting at the center 
(reference color) and moving outward into the surrounding hues. This information is 
displayed visually in the Alpha Curve graph.

Highlights: Controls the transparency in the lighter areas of the source video.

Shadows: Controls the transparency in the darker areas of the source clip.

Sensitivity: Controls the range of color accepted in proximity to the key color background. 
This control is useful for cleaning up the rough edges on dark foregrounds.

Alpha Curve: Increases and decreases the edge softness on the keyed source. This information 
is displayed visually in the Alpha Curve graph.

Alpha Curve graph: Graphically represents the Start Threshold, Transparency, and Alpha 
Curve settings. The following example explains how to read this graph.
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A) Key  B) Opaque/transparent axis (opaque at the top)  C) Subject  D) Similar colors/distant 
colors axis (similar colors at left)  E) Transparency: Sets range of transparency of reference key color 
 F) Alpha Curve: Controls the softness of edges of keyed subject  G) Start Threshold: Sets range of 
color made transparent  H) All colors in this range are fully keyed out (transparent).  I) Colors in 
this range are semi-transparent. 1: The color at this point is 25% opaque; 2: The color at this point 
is 75% opaque.  J) All colors in this range are totally opaque (subject).

Color Control area

Start Level: Controls the starting range of the desaturation curve in the input clip. The effect 
of this setting on the Color Curve graph corresponds to that of the Start Threshold setting on 
the Alpha Curve graph.

Desaturation: When a foreground is photographed against a saturated key color background, 
some of the light bouncing off of the background falls on the foreground, causing the 
foreground to change to the hue of the replaced background. This is sometimes called spill. 
Desaturation compensates for spill by reducing the saturation of certain color ranges. This can 
simplify the correction of severe color problems in the input clip. The effect of this setting on 
the Color Curve graph corresponds to that of the Transparency setting on the Alpha Curve 
graph.
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Spill Suppression: Decreases the level of spill color on the subject by adding the color 
opposite the key color to certain color ranges. This setting is used with the Desaturation 
setting.

Color Curve: Changes the dynamic of desaturation. You can use this control with spill 
suppression. The effect of this setting on the Color Curve graph corresponds to that of the 
Alpha Curve setting on the Alpha Curve display.

Post-Processing area

Shrink Matte: Shrinks the matte, which can help eliminate a troublesome halo around the 
subject. When pushed too far, this control can cause the edges of the subject to degrade and 
become transparent. Be careful if you change this setting.

Soften Matte: Blurs the edges of the matte, which can help smooth out jagged edges and 
other imperfections along the edges of the subject.

Sharpen Matte: Increases the focus at the edges of the matte. This control is essentially the 
opposite effect from the Soften Matte setting. Sharpen Matte works well with the Soften 
Matte setting to make the edges of the subject stronger and sharper.

Sharpen Range: Adjusts the direction of sharpening. This control works with the Sharpen 
Matte control.

Colors tab
Enable: Enables and disables color processing. Disabling the color correction controls lets you 
quickly compare the original source without losing the settings. For the input clip, the Enable 
check box operates independently for the Pre-Processing and Post-Processing controls.

Reset button: Returns all of the settings to the application defaults, which are neutral.

Load button: Opens a dialog box where you can choose a color correction profile.

Save button: Opens a dialog box where you can save the current color correction settings as a 
profile that you can apply to other sessions.

T
IP If you want to experiment with the keyer settings to become familiar with what each 

control does, load RGB.jpg as the input clip. This file is included with Ultra and is located 
in the Colors folder on the Backgrounds tab. Set one key point on any color, click the 
Apply Points button, and then adjust the sliders to see what happens.
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Processing mode options:

Pre-Processing: For the input clip, adjusts colors before the input clip is keyed. You 
should limit Pre-processing adjustments to the input clip to changes that enhance the 
color of the background and allow better keying. You should perform all other color 
correction for this layer by using the Post-Processing controls. For more information, see 
“Improving a background in the input clip” on page 77.

For layers other than the input clip, the distinction between pre-processing and post-
processing is irrelevant because Ultra performs no processing on these layers that is 
comparable to the keying performed on the input clip. Therefore, all color correction is 
performed by using this set of controls.

Post-Processing: Applies to the input clip only. Changes made in this mode affect the 
color of the subject after keying. You can make these changes either to offset a pre-
processing color correction that adversely changed the color of the subject or to balance 
the appearance of the subject with the appearance of the background and virtual set.

Brightness: Controls the intensity of luminance in the currently active source.

Contrast: Controls the degree of separation of light and dark shades in the currently active 
source.

Saturation: Controls the intensity of color in the current active source.

Hue: Controls the balance of colors used in the current active source.

All Channels: When selected, any changes that you make to the Level, Offset, and Gamma 
controls affect all of the color channels. When deselected, the options for Red, Green, and 
Blue are available.

Red, Green, and Blue: Selects which channel is active for adjustment through the Level, 
Offset, and Gamma controls. These options are available only when the All Channel check 
box is deselected.

Level: Adjusts the value of the current color channel on the 0-255 scale for all pixels that have 
a nonzero value in the current channel.

Offset: Adjusts the value of the current color channel on the 0-255 scale for all pixels, 
regardless of whether they originally had a value in the current channel.

Gamma: Differentially adjusts the value of the current color channel on the 0-255 scale, with 
the degree of change greatest if the original value was in the middle of the range and 
diminishing to nothing for values at the extremes.

N
O

T
E

If pre-processing color corrections are made, you may need to readjust the keyer 
settings, because they will affect the material being keyed. It is best to perform pre-
processing color correction prior to setting and adjusting a key.
User interface 39



Scene tab
Use the controls on the Scene tab to change the size, position, and orientation of some layers 
in the session. You may want to do this if, for example, you need to move the input clip so 
that it fits correctly in the scene. These controls are also used when you build your own set 
using the Basic sets. The Scene tab also contains a field for setting a pause point in a 
VirtualTrak scene.

Pause Point Settings area

This control group displays the preset start time for a pause in a VirtualTrack scene and lets 
you set the end time. These controls apply only to virtual sets from a Master Sets Library. All 
of the virtual sets that support this functionality have “with Pause” in their names.

Pause Begins At: Specifies a point in time that is specific to the current virtual set. Virtual 
sets with a pause point were created by the designer with the pause. You cannot edit this field, 
but it indicates where the pause begins.

Pause Ends At: Sets the duration of the pause. Enter the end time, which is equal to the 
desired pause duration plus the Pause Begins At time.

Size In Screen: Adjusts the size of the input clip while retaining its baseline position in the 
scene. The default size is 1.0.

Set: Sets the end point of the pause prebuilt into the virtual set using the current frame 
shown for the input clip. To use the Set button, drag the preview slider for the input clip to 
the time at which you want the pause to end.

Reset: Deletes the pause by setting the Pause Ends At time to the Pause Begins At time.

Position In Scene area

Grid control: This is an interactive control for positioning the layer plane. For more 
information, see “Changing the position and scale of a layer plane” on page 92.

Numeric readouts: You can click in a field and type a value.

X: Moves the layer plane along the x (horizontal) axis.
Y: Moves the layer plane along the y (vertical) axis.
Z: Moves the video plane along the z (depth) axis, which changes the scale of the layer 
plane. The z axis is a third dimension added to the x and y grid. The z axis is 
perpendicular to both x and y axes. To change this setting, hold down the Shift key while 
dragging vertically.
Reset: Returns all of the values to the default settings. For virtual sets, the coordinates for 
the Input Source, and sometimes for other layers, are predefined. In these cases, the Reset 
button returns the values to the predefined coordinates, not to 0.00.
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Orientation In Scene area

Grid control: This is an interactive control for setting the orientation of the layer plane. For 
more information, see “Changing the orientation of a layer plane” on page 93.

Numeric readouts: You can click in a field and type the desired value.

X: Rotates the layer plane around the x axis.
Y: Rotates the layer plane around the y axis.
Z: Rotates the layer plane around the z axis.
Reset: Returns the values to the default settings. For virtual sets, the coordinates for the 
Input Source, and sometimes for other layers, are predefined. In these cases, the Reset 
button returns the values to the predefined coordinates, not to 0.00.

Pan & Zoom tab
Instructions for using the controls on the Pan & Zoom tab are provided in “Panning and 
zooming” on page 99.

Enable: Turns panning and zooming on or off.

Pan & Zoom Points: Lists all of the points in order, and displays the time for each point. 
Selecting a point jumps to the associated frame, displays the programmed region of the image, 
and displays the x, y, and z coordinates for that position.

Add New Point: Inserts a point at the frame currently shown in the Output Preview Monitor.

Delete Current Point button: Deletes the selected point.

Time: This is an interactive field. If you add a point or select a point, the time for that point is 
displayed. If you enter a value in this field and press Enter, then the entered value becomes the 
time for the currently selected point.

Set To Preview Time: Changes the time for the currently selected point to the current time 
in the Output Preview Monitor.

Grid control: This is an interactive control that lets you use the mouse to set the framing for 
the pan and zoom point.

X: Sets and displays the horizontal position.
Y: Sets and displays the vertical position.
Z: Sets and displays the zoom setting.
Reset: Returns all of the settings to zero.
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Input tab

Timing & Settings For Input Clip area

In Point and Out Point: These controls are used to trim the beginning and ending of the 
current video clip. Trimming a clip does not change the source clip in any way. For more 
information, see “Trimming the In and Out Points in a video clip” on page 104.

Timecode: Indicates the current In Point or Out Point. This is an interactive field. You 
can click in this field, and then type a value. The default In Point is 0:00:00.00. The 
default Out Point is the last frame of the clip.
Set: Applies the current time in the clip, which is displayed in the lower-left of the Input 
Preview Monitor, to the In or Out Point. If you enter a value manually, do not click this 
button to apply the value, because the entered value will be overwritten with the current 
time for the clip.
Reset: Returns the timecode to the default (first frame or last frame).
Trimmed Duration: Specifies the length of the source video with the In and Out points 
applied. 
Original Duration: Specifies the length of the source video untrimmed.

Offset Into Scene: Defines the time in the session when the current clip starts playing. This 
is typically required with VirtualTrak scenes where the input clip or an inset is not visible 
immediately. For more information, see “Specifying when a video clip begins playing in the 
session” on page 105.

Timecode: Indicates how far into the session the clip’s start time is delayed. This is an 
interactive field.
Set: Applies the current time in the session, as displayed below the Output Preview 
Monitor, when the current clip starts playing.
Reset: Returns the Offset Into Scene timecode to zero.

Field Order: Ultra tries to set the field order automatically based on what it knows about the 
clip. If Ultra succeeds, then this can be left on Clip Default. If not, then you can use this list 
to specify which field should play first in interlaced clips or set it to Progressive for progressive 
clips. For more information, see “Set the field order (interlaced video clips only)” on page 65.

Aspect: Ultra tries to determine the source’s native frame aspect ratio. If the image appears 
stretched or squeezed, you can correct it by manually selecting the aspect ratio from this list. 
For more information, see “Setting the aspect ratio of the input source” on page 64.
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Defocus: Makes the current video clip or still image a little blurry, as if it were out of focus. 
You may want to do this to simulate depth in the composited scene, as if you had shot the 
video clip with a camera lens that had a narrow depth of field. Some older video cards do not 
support this function. In this case, this slider does nothing. This control does not improve the 
focus of a source that was out of focus to begin with. For more information, see “Defocusing 
a source” on page 119.

Loop Source: When enabled, causes the current video clip to loop for the duration of the 
scene. For more information, see “Looping the clip” on page 105.

Invert Alpha: When enabled, Ultra reverses how it interprets the alpha channel data for the 
current source. This is for compatibility with applications that interpret the alpha channel as 
film alpha, in which a value of 0 indicates complete opacity. For more information, see 
“Inputting sources that use film alpha, such as Avid (Invert Alpha option)” on page 65.

Volume: Controls the volume level of the audio in the selected source clip. The level that you 
set the audio to for each source is the level at which it will be recorded in the final output 
movie. You can also mute the audio for each clip by moving the Volume slider all the way to 
the left. For more information, see “Adjusting the volume of a video clip” on page 107.

Input Offset area

This set of controls changes the size and position of the source on the layer plane. You should 
use these controls to move a source only if you cannot achieve the desired positioning by 
using controls on the Scene tab. For some video cards, you may need to use the Input Offset 
control with the Input Cropping control to avoid artifacts. For more information, see 
“Moving and scaling an input within the layer plane: Input Offset controls” on page 95.

Grid control: This is an interactive control that lets you use the mouse to position the source.

Numeric readouts: You can click in a field and then type a value.

X: Indicates the position of the source in the horizontal axis.
Y: Indicates the position of the source in the vertical axis.
Angle: Indicates the rotational angle of the source on the layer plane. To change this 
setting, hold the Ctrl key while selecting the grid control and dragging vertically.
Scale: Indicates the size of the source. The range is 0.05 (1/20th) to 10 (10x). To change 
this setting, hold the Shift key while selecting and dragging vertically.
Reset: Returns the values to the default settings.

Check boxes: These controls let you make common adjustments with a single click.

Flip Vertical and Flip Horizontal: Flips the source vertically or horizontally. For more 
information, see “Moving and flipping the input vertically and horizontally” on page 97.
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Scale To Fit: When enabled, scales down the source so that the entire source image is 
visible in the layer plane. This assumes that all of the Input Offset values are zero. For 
more information, see “Scaling an input source to fit the virtual set” on page 98.
Plus-90 (Portrait): Rotates the source 90° clockwise. For more information, see “Turning 
the image 90° to display it in the portrait orientation” on page 97.

Input Cropping area

Use these controls to crop one or more edges of the source to mask out unwanted content in 
the frame. For more information, see “Cropping and spot masking the source clip” 
on page 83.

Grid control: Drag any of the small green handles to interactively crop the source.

Numeric readouts: You can click in a field, and then type a value.

Reset: Returns the values in all of the cropping fields to zero.

Edge Softness: Applies a transparency gradient along all of the cropped edges and painted 
masks, blending these mattes with unmatted regions so that no harsh edges are evident.

Shadows tab
The Shadows tab provides controls for adding a virtual reflection and up to three virtual 
shadows to a scene. Although it’s possible to have up to five shadows, they’re not designed to 
all be on at once, because two shadows lie on the wall and three shadows fall on the floor. The 
controls in the Settings for Shadow Region change depending on which shadow or reflection 
is selected on the left.

For instructions on enabling and setting up shadows, see “Adding shadows and reflections” 
on page 111.

Shadows & Reflections area

Reset: Returns all of the settings for the current shadow or reflection to the defaults.

Load: Opens a dialog box where you can choose a profile and apply it to the currently 
selected shadow or reflection.

Save: Opens a dialog box where you can save the settings for the current shadow or reflection 
as a profile.

T
IP You can also use the Mask Painter feature to create a matte for isolated spots rather 

than whole edges. For more information, see “Painting a mask” on page 84.
44 Product overview



Shadows & Reflections list: Select or deselect entries to enable or disable a shadow or 
reflection. To select a shadow or reflection so that the controls on the right are active, click 
anywhere on that row. The active shadow or reflection is highlighted in blue. You should not 
load the reflection settings for a shadow, or vice versa.

Appearance controls

Opacity: Controls the darkness and transparency of the shadow or reflection.

Falloff: Increasing this setting causes the shadow or reflection to fade starting at the far end.

Falloff Edge: Controls the distance over which the falloff occurs. When set to the far left 
(0.000), the shadow ends with a hard edge rather than fading over a gradient.

Blur: Increasing this setting causes the edges of the shadow to become blurred.

Floor shadow position controls

Flip Vertically check box: When enabled, displays the current shadow in front of the subject.

Baseline: Aligns the bottom of the current shadow with the feet of the subject.

Length: Controls the length of the shadow.

Angle: Controls the direction in which the shadow extends from the feet of the subject.

Spread: Increasing this setting causes the far end of the shadow to grow wider as if the light 
were close to the subject.

Wall shadow position controls

Grid control: This is an interactive control that lets you use the mouse to position a wall 
shadow.

Numeric readouts: You can click in a field, and then type a value.

X: Moves the shadow horizontally.
Y: Moves the shadow vertically.
Z: Shrinks and enlarges the shadow. To change this setting, Shift-drag vertically.

Output tab
All of the options and settings on this tab are described in “Saving the finished video” 
on page 119, except for the 4:3 and 16:9 options, which are more relevant to creating sessions 
and setting their properties. For more information, see “Creating and managing Ultra 
sessions” on page 55.
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Output Settings area

Format: Specifies the exporter, which broadly determines the type of output.

DirectShow: AVI container
QuickTime: MOV container
Frame Sequence: A series of individual still image files, one per frame, rather than a 
single video clip.

Codec: Specifies the encoder used to encode and compress the output file. The options that 
are available in this list depend on the format that’s selected. If you select DirectShow AVI, 
then the list of codecs depends on what’s installed on the computer independently of Ultra.

Configure: Opens the configuration panel for the selected codec. This button is disabled for 
codecs that do not have any configuration options available.

24-bit / 32-bit Keyed Source: These options are available if you set the format and codec to 
QuickTime and Apple None or one of the other file formats that supports an alpha channel.

24-bit: Creates an output file with no alpha channel.
32-bit Keyed Source: Creates an output file with an alpha channel for use in another 
compositing application. The extra 8 bits per pixel is for the transparency information.

Invert Alpha: This option is available if you select 32-bit Keyed Source. When enabled, Ultra 
reverses how it encodes the alpha channel data. This is for compatibility with applications that 
interpret the alpha channel as film alpha, in which a value of 0 indicates complete opacity.

Type 1 and Type 2: These options are available if you set the format to DirectShow and set 
the codec to DV Video Encoder.

Type 1 DV: Saves a single stream containing both the video and audio.
Type 2 DV: The output consists of two streams: one stream for the audio and one stream 
for the video. This format is compatible with more applications than the Type 1 DV 
format.

Resolution: Specifies the dimensions of the frame for the output movie, in pixels. You cannot 
change the resolution for some codecs.

Frame Rate: Specifies the frame rate, in frames per second (fps), for the output movie.

Field Order: Specifies whether the output movie is progressive or interlaced. If the output 
movie is interlaced, this setting specifies which field is first.

Flicker Filter: If the output video has sharp lines of contrast and will be viewed on a 
television, reduces flickering or strobing along those lines.

File Information area

Folder: Displays the path where the output movie is saved.
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Browse: Opens a dialog box where you can specify the path where the clip is saved.

File Name: This is an interactive field for entering and displaying the name by which the clip 
is saved.

Total Duration: This display-only field shows the length of the output video.

Estimated Size: This display-only field indicates approximately how large the video output 
file will be (in megabytes) if you save it with the current settings. If the currently selected 
codec uses a variable-bit-rate compression method, then nothing is displayed here.

Time Remaining: This display-only field shows an estimate of how much longer it will take 
to finish saving the movie.

Save Output: Starts rendering and saving the video file with the current output settings.

Progress: Displays a progress bar indicating how much of the session has been rendered and 
encoded.

Libraries
The five tabs on the right that contain the folder icons are for accessing Ultra sessions, various 
files that you use in the sessions, and the movies that you produce with Ultra.

Virtual Sets tab

This tab provides access to all of the virtual sets that are installed. Ultra CS3 includes the 
MSL1 Master Sets Library. If you have Ultra without additional Master Sets Libraries 
installed, then this tab contains the Basic folder, MSL1, and samples of virtual sets from the 
other Master Sets Libraries. For more information about virtual sets, see the following 
sections:

“Virtual sets” on page 24
“Assigning content to layers” on page 63
“Customizing a virtual set” on page 73

Backgrounds tab

The default path for this library is where the set of backgrounds included with Ultra are 
installed. Be sure to check out the Animations subfolder for the collection of dynamic 3D 
backgrounds that are provided standard with Ultra. For instructions on setting one of these 
images as a source, see “Assigning content to layers” on page 63.
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Output Clips tab

The path for this library is to the default location where the Ultra clips are stored when you 
save the output of a session. Changing the location where output movies are saved does not 
change this library’s path. For more information, see “Saving the finished video” on page 119.

Sessions tab

This library is for accessing Ultra sessions. Files in this library have an extension of .mks. The 
library’s initial path is the default location where sessions are saved. For more information, see 
“Creating and managing Ultra sessions” on page 55.

Browse tab

Whereas the other library tabs let you navigate to any folder on the system, this tab is 
specifically intended for this purpose. If you store raw input clips and background stills in one 
location, Adobe recommends that you set that folder as the home for the Browse tab.

Assigning a folder as a library’s home
1. Click the desired library tab.

2. Navigate to the desired folder using the address bar.

3. Right-click a blank spot in the library. A context-sensitive menu is displayed.

4. Select Set Current Directory As Home for '<library>'.

Resetting a library tab to the default home

If you set a custom home for a library and want to revert to the default, click the library tab, 
and select Reset Default Home Directory For '<library>'.

Setting Ultra to remember the last folders that you were in

By default, each time you start Ultra and open a library, Ultra goes to the home folder for that 
library. If you prefer to have Ultra keep track of which folders you were in at the end of the 
last session, select Tools > Application Settings, and then select Remember Current Folders.

Application menus
This section describes the menus at the top of the Ultra application window.

File menu
New > New 4:3 Session (Ctrl+N) or New 16:9 Session (Ctrl+W): Creates a new Ultra 
session. For more information, see “Creating a session” on page 55.
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Open Session (Ctrl+O): Opens a previously saved Ultra session. For more information, see 
“Opening a session” on page 55.

Save Session (Ctrl+S): Saves the current session. For more information, see “Saving a 
session” on page 56.

Save Session As: Saves the current session under a different name. For more information, 
see “Saving a copy of a session” on page 56.

Load Settings or Save Settings: Specifies which type of profile to apply to the current 
session or save from the current session.

Keyer (See “Saving and applying Keyer settings” on page 88.)
Color (See “Saving and applying color settings” on page 110.)
Shadow (See “Saving and applying settings for a shadow or reflection” on page 118.)

Recent Virtual Sets: Loads a recently assigned virtual set.

Recent Inputs: Loads a recently assigned input source.

Recent Sessions: Loads a recently opened Ultra session.

View menu
Input Clip Preview Background: Sets the background for the input clip in the Input Preview 
Monitor to either the unkeyed original view (Alt+O) or the checkerboard alpha view (Alt+A). 
This option is used only if the input clip is the active layer, it’s keyed, and the keyer is 
enabled. For more information, see “Input area and Input Preview Monitor” on page 28.

Displayed Inputs: Specifies whether the layer thumbnails between the two monitors display 
the default user-defined sources (Alt+U) or the sources predefined by the current virtual set 
(Alt+P). To change the size, position, orientation, or color of any part of a virtual set, you 
must switch to the predefined view. For more information, see “Customizing a virtual set” 
on page 73.

Safe Area Overlay: When this option is enabled, a white rectangle displays over the Input 
Preview Monitor and Output Preview Monitor to indicate the area of the image that is 
certain to be visible if the output movie is viewed on a television. Content outside this area 
may or may not be visible, depending on the particular television set. For more information, 
see “Input area and Input Preview Monitor” on page 28.

Toggle Full-Screen (Alt+Enter): Toggles between full-screen video playback and the Ultra 
interface. For more information, see “Output Preview Monitor and previewing the output” 
on page 31.
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Tools menu
One-Click Key/Apply Points (Ctrl+K): Applies either the Set Key or Apply Points method to 
the input clip in the Input Preview Monitor. For more information, see “Setting the key” 
on page 76.

Clear All Key Points (Ctrl+E): Clears all of the points from the input clip in the Input 
Preview Monitor. For more information, see “Multiple Key Points Method (Color Spread)” 
on page 80.

Undo Last Key Point (Ctrl+Z): Clears the last key point entered. You can press Ctrl+Z 
repeatedly until you’ve cleared all of the key points entered.

Application Settings (F3): Opens the Application Settings dialog box, where you can set the 
following parameters:

Default Virtual Set field and Browse button: Specifies which virtual set is loaded for 
each new session. The Browse button opens a dialog box in which you can select a 
different set as the default. For more information, see “Creating and managing Ultra 
sessions” on page 55.
Live Preview Setup controls: Configures the system for Live Preview, which is intended 
primarily for checking the quality of the lighting and camera settings prior to shooting 
content to be keyed in Ultra. For more information, see “Live Preview” on page 57.

Device: Lists the compatible live video devices that are connected to the computer.
Underscan: Displays the percentage of underscan applied to the horizontal edges of 
the input source. This setting is involved in removing the black bars generated by 
some camcorders.
Resolution: Specifies the video resolution for the Live Preview. For slower computers, 
you may need to reduce this setting.

Remember Current Folder: When enabled, saves the path for each library tab each time 
you close Ultra and restores the paths the next time you start Ultra. When disabled, resets 
the libraries to the default paths each time you close Ultra. For more information, see 
“Assigning a folder as a library’s home” on page 48.
Start Up In Last Session: When enabled, automatically opens the last session you were 
in when you start Ultra. When disabled, Ultra starts with a new, blank session. For more 
information, see “Opening a session” on page 55.

Play menu
These commands control the playing of the session in the Output Preview Monitor.

Play/Pause (space bar): Plays and pauses.
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Go To First Frame (F5): Displays the first frame.

Previous Frame (F6): Displays the previous frame.

Next Frame (F7): Displays the next frame.

Go To Last Frame (F8): Displays the last frame.

Loop Mode (F9): Plays from start to finish, continuously.

Help menu
Help (F1): Accesses the built-in Help document.

Online Support: Starts a web browser and opens the Ultra support page on the Adobe 
website.

FAQ: Starts a web browser and opens the Ultra FAQ web page.

Find More Sets Online: Starts a web browser and opens the Master Sets Library page on the 
Adobe website.

Updates: Checks for updates for Ultra.

About Adobe Ultra: Shows information about the currently installed version and your 
computer system.

Right-click context menus
This section describes the menu options that are available when you right-click on various 
areas in the Ultra application window.

Text and number boxes
Right-click in a text box for a standard text-editing menu with Undo, Cut, Copy, Paste, 
Delete, and Select All commands.

Background and Input Clip thumbnails
For more information, see “Assigning content to layers” on page 63.

Assign Black, Assign White, or Assign Checkerboard: Assigns a black, white, or 
checkerboard image as the source for the selected layer.

Reassign Last Source: Assigns the previously assigned file as the source for the selected 
layer.

Unload Source: Removes the source assignment from the selected layer.
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Overlay thumbnail
For more information, see “Adding overlay layers” on page 66.

Add New Overlay: Adds a new entry so that you can load a new overlay graphic to the 
current session.

Remove Current Overlay: Deletes the overlay from the current session.

Output Preview Monitor
Reset All: Resets all of the zoom and positioning in the Output Preview Monitor to the 
defaults.

Reset Position: Resets all of the positioning in the Output Preview Monitor to the defaults.

Reset Magnification: Resets all of the zoom in the Output Preview Monitor to the defaults.

Grid controls on the Scene, Input, and Pan & Zoom tabs
If an option is dimmed, it is not available for the current grid.

Reset All: Resets all items to the defaults.

Reset Scale: Resets the scale to the defaults.

Reset Position: Resets the position to the defaults.

Reset Angle: Resets the angle to the defaults.

Rotate +90: Rotates the grid 90º clockwise.

Rotate –90: Rotates the grid 90º counter-clockwise.

Rotate 180: Rotates the grid 180º.

Flip Vertical: Flips the grid vertically.

Flip Horizontal: Flips the grid horizontally.

Zoom In 2x: Zooms in on the current grid to 200%.

Zoom Out 2x: Zooms out on the current grid to 50%.

Items on the Virtual Sets, Backgrounds, Output Clips, 
Sessions, and Browse library tabs
If an option is dimmed or not present, it is not available for the current item.

Open: Opens the selected file.

Play: Plays the selected video file.

Copy: Copies the file to clipboard.
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Delete: Deletes the file from storage (e.g., hard disk).

Rename: Opens the name field for editing.

Blank spot on one of the library tabs
If an option is dimmed or not present, it is not available for the current item.

Paste: Pastes the file from the clipboard.

Create New Folder: Creates a child folder in the current folder.

Set Current Folder As Home For: Makes the current folder the default for the current 
library.

Reset Default Home Folder For: Reverts the default folder to the application default for the 
current library.
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4

CHAPTER 4

How to
Creating and managing Ultra sessions
In Ultra, a session is the basic framework within which you work to create a composited 
movie. An Ultra session is very similar to a composition in Adobe After Effects. Each session 
contains multiple layers that are composited together, and each of these layers has a video, 
image, or virtual set file that it refers to for source content. In each session, you specify 
settings, such as the keyer settings. When you save a session, Ultra creates a file with an 
extension of .mks that stores information about the inputs and settings.

Creating a session
To create a session, choose File > New > New 4:3 Session (Ctrl+N) or New 16:9 Session 
(Ctrl+W). The choice of session type sets the frame aspect ratio on the Output tab. The 
session’s frame aspect ratio also affects the Input Preview Monitor and Output Preview 
Monitor, as well as the grid controls on the Scene, Pan & Zoom, and Input tabs.

Changing the default virtual set
The default set is Simple Keyed Clip.mfx or Simple Keyed Clip 16x9.mfx, depending on 
whether the session is a 4:3 or 16:9 session. To change the default virtual set, choose Tools > 
Application Settings (or press F3), and then click the Browse button to select the virtual set.

Opening a session
To open a session, click the Sessions tab, and double-click the thumbnail image for the desired 
session. 

If you prefer to work through a standard Windows dialog box, then choose File > Open 
Session or press Ctrl+O. The dialog box displays only folders and Ultra session files (.mks). 
Browse to a session, and either double-click it or select it and press Enter.
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You can also open a session by double-clicking the .mks file in any file manager (for example, 
Windows Explorer) or by dragging and dropping the file from a file manager to Ultra.

By default, Ultra opens a new, blank session. If you prefer to have Ultra open the last session, 
choose Tools > Application Settings (or press F3), and select Start Up In Last Session.

To open a recently open session, choose File > Recent Sessions.

Saving a session
To save a session, choose File > Save Session, or press Ctrl+S. The first time you save a session, 
a dialog box appears in which you can enter a name for the session and select the location to 
which the session is saved.

Changing the default session’s path
The default folder for saving sessions is \My Documents\Adobe Ultra CS3\My Sessions, 
which is also the default path for the Sessions tab. Each time you save a session, the path to 
which you save the session becomes the default path for new sessions.

Saving a copy of a session
Saving a copy of a session is an easy way to back up your work or create a new session that uses 
some of the same input assignments or settings as an existing session. To make a copy of a 
session, choose File > Save Session As, and save the session with a new name or to a new 
location.

Working with a session on a different computer
When you copy or move a session from one computer to another, you must transfer the .mks 
file and any source files that are used in the session but not included as part of Ultra or an 
installed Master Sets Library. The source files must be where Ultra expects to find them.

If sources are in the default, \Program Files\Adobe\Adobe Ultra CS3\Content location, then 
Ultra can find them. If the session uses any files that are not stored in the Content folder, then 
you must save them to the location with the identical path on the second computer. For 
example, if the files were in the Custom Ultra Content folder in My Documents, then you 
must replicate the full path, including the username. Alternatively, you can save the files 
wherever you want to on the second system, and then reassign the affected sources.

N
O

T
E

Saving a session has nothing to do with saving or rendering a composited output movie. 
For more information, see “Saving the finished video” on page 119.
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Creating and assigning sources and 
virtual sets
This section describes how to prepare graphics and video clips for use in Ultra, customize the 
sets that come in the Master Sets Libraries, and assign graphics and virtual sets within a 
session.

Shooting video for Ultra
With the sophisticated keying technology built into Ultra, you can make use of even poorly 
shot source footage. Even so, the better the quality of the input, the better the resulting key 
will be. In fact, Ultra simplifies or eliminates so many of the technical problems associated 
with keying that the biggest remaining factor in achieving excellent output is the quality of 
the input clip, in particular the color and saturation of its background.

Live Preview
Using the Live Preview feature, you can preview the video feed from the camera as the input 
clip, composited in real time while you are shooting. Connect the camera to the computer 
and choose Live Preview from the list under the Input Preview Monitor to use the live feed 
from the camera as the input clip. You can then set the key as you normally would and check 
for problems such as hotspots, wrinkles, shadows, and color spill from the background onto 
the subject. This helps you to evaluate whether the current lighting, background, and framing 
will key well and work with the intended virtual set when keyed later in post-production. 

Live Preview is intended only for evaluating the setup before recording clips. Ultra does not 
support real-time keying output of a live source.

Switching to Live Preview does not affect the input clip assignment, if there is one. In fact, 
you can use the list under the Input Preview Monitor to toggle between Live Preview and the 
current input clip.

To configure Live Preview, choose Tools > Application Settings, and modify settings as 
needed:

For Ultra to use a DV camera for Live Preview, the camera must be on and connected via 
an OHCI-compliant IEEE-1394 port before you start Ultra. The camera must be 
recognized by the computer as a video device. You can verify that the camera is recognized 
by looking for the camera as a device in the My Computer area in Windows. If the camera 
doesn’t appear, then the computer may have detected more than one video input source. 
In this case, you must choose the correct device from the Device list in the Application 
Settings dialog box.
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Because decoding DV in real time requires a lot of processing power, Adobe recommends 
that you use a fast computer. On slower computers, you may need to lower the Resolution 
value, which controls the preview resolution.
Some video cameras output thin black bars in the overscan areas on the right and left 
edges. You can change the Underscan value in Ultra to delete these bars. Ultra stretches 
the image by the specified amount, preserving the frame aspect ratio of the live input. This 
setting applies only in Live Preview mode.

Setting up the camera
You should always disable automatic color settings on the camera when shooting for color 
keying. Otherwise, the background’s brightness or hue may change when on-camera subjects 
move across the frame. Adjusting the camera manually, try to match the intended virtual 
background as closely as possible by adjusting the iris, white balance, shutter speed, and other 
camera-specific parameters.

Ultra works best when the camera is locked down on a tripod. In most modes, Ultra uses a 
static model of the background. If the camera moves, then the model will not remain aligned 
with the variations in the background. If a clip involves any camera movements, then the only 
way that you can key it in Ultra is with the single key point method, which works entirely by 
color without a model. For more information, see “Single Key Point Method (One Color 
Pickup)” on page 79.

Controlling the lighting
Controlling the lighting of the foreground scene helps you to achieve realistic results. The goal 
is to adjust the foreground to match the intended virtual background. Analyze the intended 
background—either a virtual set or your own still image or video clip—to determine the 
direction of the primary light source for the background scene. Position the lights at the same 
relative positions so that the subject receives the same general lighting as elements in the 
background. For example, if the background is strongly lit and leaves hard shadows and shiny 
highlights, then you want comparable lighting on the subject in front of the color screen. 
Getting the subject’s shadow right can significantly enhance the realism of the final 
composited shot.

Although you can tune the key to preserve shadows from the input clip, you can also generate 
shadows digitally by using Ultra. This approach has several advantages over working with 
actual shadows. Most notably, you can easily control the shadow’s position, scale, and opacity 
as well as several other attributes. For more information, see “Adding shadows and reflections” 
on page 111.
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After you adjust the lighting and camera settings so that the input clip matches the virtual 
background as closely as possible, you can bring them closer still by performing color 
corrections in Ultra. You can color-correct each layer independently. Sometimes adjusting the 
color of the background to match the input clip can yield better results than correcting the 
keyed input clip itself. Often a combination of both is ideal.

Framing the subject
Set the angle, height, and field of view for the camera to match the characteristics of the 
virtual background that you are using. It’s always best to frame the subject as tightly as 
possible for the selected background. This maximizes the resolution of the image, which 
translates to higher quality. By contrast, if you shoot the subject with a larger field of view 
than you are using, you’ll end up cropping and probably scaling up the remaining image, 
thereby throwing away a substantial portion of the camera’s resolution. Scaling down an 
image that’s too large preserves quality, and scaling up an image that’s too small degrades the 
image.

Virtual sets from the Master Sets Libraries are designed to work best with input clips of a 
particular framing. The main standardized framings are tight, medium, and wide. The names 
of nearly all of the virtual sets in the Master Sets Libraries indicate the framing for which they 
are designed. The consistency of framing across the Master Sets Libraries provides a valuable 
advantage. The scale and position of the subject are preset for each virtual set. Therefore, you 
don’t have to think about the scale of the subject in the final composited scene when shooting. 
For example, if the set shows a full-body view of a person who’s scaled down and positioned 
on a stage, you should still shoot with the standard wide framing (with the person’s head near 
the top of the frame and their toes near the bottom). Don’t try to frame subjects as they will 
be positioned in the final composited scene; the set will handle the scaling automatically. One 
of the advantages of shooting to the three standardized framings is that you can use a shot 
with a given framing in any set designed for that framing. This allows great flexibility in post-
production.
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The following is a key to the main scales to which you should shoot.

A) Tight: Close-up shot, approximately from the chest up  B) Medium: Medium-distance shot, 
approximately from the waist up  C) Wide: Wide-angle, full-body shot, with space above and below 
the subject

Always shoot the subject centered within the frame laterally—or at least not cropped on either 
side. If the subject is partially out of the frame in the composited layout, it’s easy to move the 
layer to the side. Conversely, if you crop an arm at the shoulder while shooting and later 
decide that you want to position the subject more toward the center frame than you 
anticipated, you can’t put the arm back in the frame.

Optimizing the color screen backdrop
A high-quality color backdrop that is properly lit yields superior results. There are several 
aspects to a good backdrop.

Color and finish: Adobe recommends green as the best backdrop color for typical Ultra usage. 
In some cases, however, green isn’t the best backdrop color, and other colors will work. For 
example, if your subject must wear green clothing, you may get better results with a blue 
screen. In general, the best key color is a color that is not used in your subject. If you use key 
color paint, apply several coats and allow adequate drying time to increase color saturation. If 
you use an improvised backdrop material, ensure that the color is deeply saturated and that 
the surface has a smooth matte finish. Avoid shiny or textured surfaces.

Flatness: If you use a cloth or plastic sheeting, reduce the wrinkles as much as possible. A 
hand-held clothes steamer can be helpful. For a free-hanging cloth, stretch it tight enough to 
remove the folds and prevent rippling from air currents. You can use the elastic straps with 
clips designed for holding bedsheets to mattresses for this purpose.

T
IP If the subject is a person who’s standing or sitting and won’t move much or gesture 

widely, try shooting with the camera turned sideways to make maximum use of the 
camera’s resolution.
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Lighting: Whenever possible, light the backdrop separately from the foreground subject. This 
requires moving the subject as far from the backdrop as possible to create space for two 
separate lighting zones that don’t interfere with each other. If this brings areas beyond the 
edges of the backdrop into view, you can delete them with Mask Painter tool or by cropping 
the edges. Just keep the subject entirely in front of the backdrop. For more information, see 
“Painting a mask” on page 84 or “Cropping the edge of a frame” on page 84.

Lighting on the backdrop should be as even as possible, without hotspots or shadows. 
Umbrella reflectors and soft box diffusers are ideal for providing the desired results. A light 
meter or in-camera zebra pattern indicator can help ensure that the backdrop is evenly lit and 
deeply saturated.

Reducing spill
Colored light spilling from the background onto the subject can interfere with getting a 
convincing key. Although spill suppression features in Ultra can greatly reduce color spill 
problems, being careful while you’re shooting is better yet. Keep the following points in mind:

The larger the background, the more significant this issue tends to be. That’s because 
every square inch of colored background reflects light of the background’s color.
In wide shots with the subject standing on a color screen, the floor also becomes a source 
of bounced light. To minimize spill from the floor, reduce the amount of key color 
flooring in front of the subject. One way to accomplish this is to place a black drop cloth 
immediately in front of the farthest point forward that the subject’s feet will reach. You 
can use the Input Cropping controls to trim out everything in front of the subject’s feet.
A nearby white wall beside the background or behind the camera can compound the 
problem by bouncing more colored light back onto the subject. To minimize this 
problem, set up the key backdrop in an area without nearby light-colored walls.

Choosing the subject’s wardrobe
Ultra does not know whether a green pixel is part of the backdrop or the subject’s necktie, so 
ensure that the subject isn’t wearing anything that’s too close to the color of the backdrop. 
Otherwise, you’ll be looking right through the subject to the virtual set behind.

T
IP For each clip that you record and then key and composite in Ultra, ensure that you get at 

least a few frames that show only the keying background as it will be lit and framed for 
the shot. Frames with nothing in the foreground let you use the Set Key method, which 
not only produces the highest quality key but is also the easiest to use. For more 
information, see “Set Key” on page 78.
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Choosing the background or virtual set
The best results are achieved when the virtual background and the subject are similar not only 
in brightness but also in color saturation, hue, and contrast. When selecting a background or 
virtual set to be digitally inserted behind a particular foreground subject, look for one that will 
match reasonably well in these regards. You can apply color correction settings in Ultra to 
make sources match even better, but it’s best to not rely on digital color correction to make 
divergent sources match exactly.

Directing on a virtual set
Performing in an imaginary environment can be challenging for the actor portraying your 
subject. Powerful technology like Ultra now means that the subject must not only get into 
character but also into location. Actors tend to perform differently depending on the size of 
the space they are in and how far away the camera is. Now that you can digitally manipulate 
these aspects with such ease, actors will need some coaching and feedback to help them work 
with the virtual environment during shooting. You should encourage the subject to look 
around the environment and gesture to virtual objects such as on-set monitors as appropriate. 
If they are going to be digitally scaled down to simulate a far-away camera, the subject must 
project their voice as they would when performing to a far-away camera. If the subject will be 
inserted into a large virtual environment with a distant camera, they may want to be more 
expressive with their arms and entire body.

Details help complete an illusion. How the subject is dressed and what props they’re holding 
can sell the scene to the audience and help the actors hold their mental image of the virtual 
environment. If the virtual background will be footage of a hot day at the beach, for example, 
you may want to consider adding a little sweat to the brow or some ocean breeze from an off-
camera fan.

Improving the quality of the source footage and facilitating 
recording
Adobe® OnLocation CS3 can take a lot of the guesswork out of recording video that will key 
well. OnLocation provides tools that will help you improve the quality of the video that you 
shoot. Two tools in particular, the Waveform Monitor and Vectorscope, can be invaluable 
when you’re recording footage that you will then key in Ultra. These tools digitally analyze 
every pixel of every frame in the video stream and graphically display the brightness, color, 
and saturation. With this information, you can adjust the camera settings, lighting, and other 
variables in the shooting environment to achieve the cleanest, most consistent background 
possible. OnLocation also lets you record clips directly to an internal or external hard disk. As 
soon as you stop recording, you have a digitized input clip ready to drop into Ultra. Even if 
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you don’t actually set up the whole session and render out the composited footage, you can at 
least set the key in a minute or less to confirm that all will go smoothly during post-
production. To learn more about OnLocation, go to the Adobe website (www.adobe.com), 
and download a free trial version.

Assigning content to layers
This section explains how to assign a source to a layer and addresses some of the fine points of 
dealing with sources.

Assigning source content to a layer
Ultra provides several methods for assigning an image, video clip, or virtual set to the 
appropriate layer. Most of these methods apply the selected source to the active layer. For 
more information, see “Active layer” on page 24. If the correct layer isn’t selected, either click 
its layer thumbnail or use the list under the Input Preview Monitor. For the inset and overlay 
layers, you may also have to choose the desired layer (Source B, C, and so on; or Overlay 1, 2, 
and so on) by using the list above the layer thumbnail. After the layer is selected, any of the 
following actions assign a source to it. These methods also work for assigning a virtual set.

Double-click the source’s thumbnail image in a library tab. When you double-click the 
thumbnail image for a still image or video clip on one of the tabs, that image or clip is 
assigned as the source for the active layer. Double-clicking a virtual set, however, assigns it 
to the Virtual Set layer, regardless of which layer you select.
Right-click the source’s thumbnail image in a library tab, and choose Open.
Drag the source’s thumbnail image from a library tab onto the Input Preview Monitor or 
Output Preview Monitor.

You can assign a source to any layer, regardless of which one is active, by dragging and 
dropping the source’s thumbnail image directly on the layer’s thumbnail. As with the previous 
options, you may need to select the specific inset or overlay first. Assigning a source to a layer 
by dragging the source to the layer thumbnail does not make that layer the active layer.
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Changing sources for a layer

The methods outlined previously work regardless of whether a source is already assigned to 
the layer. When you change the source assignment, the new source inherits most of the 
adjustments to the layer that were made on any of the tabs. The only exceptions are the In and 
Out points for trimming a video clip. This lets you experiment with different combinations 
without having to redo any of the settings. For example, you can review multiple takes of a 
given shot quickly and easily. If the source that you substitute differs substantially in lighting 
or key color background from the source that you originally keyed, you must recalibrate the 
keyer.

You can change to a white, black, or checkerboard source by using the right-click menu for 
the layer thumbnail.

With virtual sets, the assignment of sources to inset layers is preserved, even if you switch to a 
set that doesn’t have all of the insets. If you later change back to a set that includes those 
sources, you do not have to reassign them. However, the scale, position, and orientation 
settings for the input clip and inset sources are overridden by those that are predefined for 
each virtual set.

Unassigning content from a layer

If for any reason you want to remove a source from a layer, which leaves the layer blank, right-
click the layer thumbnail, and choose Unload Source or Remove Current Overlay.

This option isn’t available for the virtual set because something must be assigned at all times. 
If you want to delete the current set, you must assign another set. 

To remove a virtual set and return to the default, select the Simple Keyed Clip virtual set 
found in the Basic folder of the Virtual Sets tab.

Setting the aspect ratio of the input source

When you assign a video clip as a source, Ultra tries to determine its native aspect ratio but is 
sometimes unable to do so. If a clip or still image appears stretched or squeezed, you can 
correct it by selecting the correct setting from the Aspect menu on the Input tab.
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If you are creating several composited clips for a single scene within a given Master Set 
that has insets or to which you’re adding overlays, you can eliminate the need to assign 
the same set of sources to those layers each time by copying the sessions. Rather than 
creating each related session from scratch, make a copy of one that’s already set up. 
You can then switch the virtual set and input clip, preserving the assignment of sources 
to inputs and overlays. You must still assign sources to any layers that didn’t exist in the 
session that you copied.
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Inputting sources that use film alpha, such as Avid (Invert Alpha option)

Video systems conventionally interpret an alpha channel value of 0 to indicate complete 
transparency. Film systems conventionally interpret an alpha channel value of 0 to indicate 
complete opacity. When importing a video source from a system that uses film alpha (such as 
Avid), use the Invert Alpha option on the Input tab.

Set the field order (interlaced video clips only)

Interlaced video is divided into alternating fields, called upper and lower. Field order specifies 
which field of interlaced video is drawn to the screen first. You must ensure that the field order 
setting for each interlaced video clip is the same as that clip’s native field order. 

Standard-definition video (such as NTSC DV) is typically lower-field first, whereas PAL D1 
and many high-definition formats (such as DVCProHD 1080i) are upper-field first. If you 
choose the wrong field order for a clip, you’ll see a comb-like edge around the subject and 
stuttering with movement in the image.

1. Assign the video clip to the desired layer, and select it as the active layer.

2. Select the appropriate setting from the Field Order list on the Input tab.

Matching the aspect ratio of a basic set’s background with a 
session
Each virtual set has a native aspect ratio. In most cases, you should match the aspect ratio of 
the set to the aspect ratio of the session that is specified on the Output tab. However, Ultra 
lets you mix them if that suits your purposes.

Matching input clips and virtual sets
You should match each input clip with a virtual set that roughly matches the framing. For 
most virtual sets, the title indicates the framing, with Tight, Medium, or Wide in parentheses. 
The exceptions are VirtualTrak sets, which are designated as Trak, and sets where the input 
clip appears as an inset, which have nothing in parentheses in the titles. For VirtualTrak sets, 
you must preview the tracking shot to determine its framing. For sets that display the input 
clip as an inset, any framing works.
Creating and assigning sources and virtual sets 65



A) Tight: Close-up shot, approximately from the chest up  B) Medium: Medium-distance shot, 
approximately from the waist up  C) Wide: Wide-angle, full-body shot, with space above and below 
the subject.

Adding overlay layers
You can add up to four overlays to any session, regardless of whether the virtual set has one or 
more foreground elements. By default, one empty overlay layer exists in each session. To add 
an overlay, right-click the thumbnail for an existing overlay that has a source assigned, and 
choose Add New Overlay. This option is unavailable if the current overlay has no source 
assigned or if four of these layers already exist.

Using a still image as the input clip
You can assign any supported graphic format as the input clip, key it, and then output a 
composited still image or video clip.

To output a still image, use the Frame Sequence format. For more information, see 
“Outputting still images (Frame Sequence)” on page 122.
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Panning and zooming over an entirely still scene: If the input clip and all of the other 
sources are still images and you want to output a video clip in which the action is a virtual 
camera move across the composited scene, then the input clip must have a duration. Select 
the input clip as the active layer, or any other layer, and enter a time in the Out Point field 
on the Input tab. If you’re not yet certain exactly how long the session will be with the 
virtual camera moves, set a value higher than you expect to use, and then reduce it after 
you apply all of the camera moves.

Supported input formats
Ultra supports HD and HDV video, QuickTime video files, and an expanded list of graphic 
formats. The following table provides a partial list of supported video and graphics formats. 
The list isn’t complete because compatibility depends in part on what codecs are installed on 
the computer.

Format Resolution (frame 
dimensions)

Frame rate

High definition 
(HD and HDV)

1080i
1080p
720p

NTSC: 60i and 30p
PAL: 50i and 25p
Film: 24p 
(nonpulldown)

Standard definition (SD)
Uncompressed 24-bit

NTSC: 720x480 and 720x486
PAL: 720x576 

Uncompressed 32-bit AVI (with 
alpha)

DV AVI Type 1 (audio and video 
on separate streams)

DV AVI Type 2 (audio and video 
on the same stream)

MPEG-1, MPEG-2 (.mpg, .mpeg, 
.m2v, .m2t)

QuickTime (.mov)

Windows Media (.wmv)

Adobe virtual set (.mfx)
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When you ran Ultra for the first time, you chose either NTSC or PAL. Regardless of which 
video format you chose to work with, you can use video clips of either format as sources. 

You can use still images with dimensions of up to 4096x4096 pixels as sources if the graphics 
card supports that resolution. Ultra preserves the native resolution of all graphics sources up 
to 4096x4096. One advantage of this is that when you zoom in the image remains crisp and 
unmarred by the blockiness the comes from enlarging low-resolution graphics.

In general, however, the format of the video clips and the dimensions of the still images used 
as sources should be consistent with the video format in which you’ll output the finished clips.

Creating elements for a set or individual layers
Virtual sets are bundles of visual elements that work together to produce the illusion of a 
three-dimensional set. The virtual sets that come in the Master Sets Libraries are advanced 
designs. Some of these virtual sets have foreground elements and multiple insets, each with a 
letter designating which source it is. The Basic sets that are installed with Ultra let you achieve 
comparable results using your own graphics for background and foreground elements. You 
must apply an alpha channel where you want transparency through to the next layer in the 
composited scene.

This section explains how to create the elements that make up a virtual set. The principals are 
the same regardless of whether you’re working in an image-editing application such as 
Photoshop or a 3D application such as Maya™ or 3DMax™. Keep the following general 
pointers in mind as you proceed:

Supported file types: PNG, JPEG, BMP, PPM, TIFF and Targa (TGA).

Still images
.bmp
.jpg
.png 
.ppm
.tga
.tiff

up to 4096x4096 (graphics 
card permitting)
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If you assign a video clip to any layer other than the input clip, you may need to trim it or 
set it to loop so that it ends at the same time as the input clip, if that's your goal. For more 
information, see “Trimming the In and Out Points in a video clip” on page 104 or 
“Looping the clip” on page 105.

Format Resolution (frame 
dimensions)

Frame rate
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Transparency: Save any layer that has transparent regions in a format that supports an 
alpha channel, such as .png and .psd files. To learn more about alpha channels and how to 
save layers in a format that preserves transparency, see the image-editing application’s 
documentation.
Perspective: Shoot the still images that you’re using for a set from the height and angle that 
you’re using for the main subject. If you’re using computer-generated graphics, design 
them with the camera’s perspective in mind.
Lighting: Light the scene from the same angle from which you’re lighting the subject 
when shooting the input clip.
Multiple angles: If you have multiple scenes with different angles of the same set, you 
must prepare the images from each angle. For the most consistent, realistic appearance, 
light all of the sets from the same absolute or global perspective.
Aspect ratio: Ultra does not force images to the 4:3 aspect ratio.

Backgrounds
There are two basic types of backgrounds: background with one or more transparent regions 
cut in it to show the sources behind it, and backgrounds without transparent regions. 
Backgrounds without transparent regions are simple to create. You can assign any image of a 
supported file type as a background. As a rule, you want the frame aspect ratio for the 
background to be the same as that for the session as set on the Output tab.

For backgrounds that you use with one or more inset sources, you must create an alpha 
(transparency) region in the image for each inset. In Photoshop and other image-editing 
applications, this can be accomplished in many ways, including using masks.

If the alpha region is on in a surface that is angled to the plane of the camera’s lens, then you 
should adjust the perspective of the alpha region accordingly. You typically need to change the 
size, position, and possibly orientation of the inset source to appear in the correct space. For 
more information, see “Changing the position and scale of a layer plane” on page 92 and 
“Changing the orientation of a layer plane” on page 93.

T
IP To achieve more advanced results:

• To produce a dynamic result like those from VirtualTrak shots from the Master Sets 
Libraries, use the pan and zoom features. For more information, see “Panning and 
zooming” on page 99.

• To show the input clip as an inset, create an overlay with an alpha region where you 
want the keyed input clip to appear, and then scale and position that clip and its 
background to fit in the designated space.
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When you create the alpha region, it is often best to draw a frame around it, as well, such as 
the pink border drawn around the alpha region in this example.

Overlays
The foreground element can be any object or structure that you want to appear in front of the 
subject for at least part of a scene. The foreground could be a prop such as a chair that lends 
dimension or a door that the subject emerges from behind. In the following example, the 
foreground is a desk.

For photographs, you can either copy the overlay from the background and paste it back in as 
a separate layer or add an object from another image. If you’re drawing the elements in an 
image-editing or 3D application, then you should put each element on its own layer.

For videos, you can use Ultra to create the keyed overlay.

1. Record the clip as you would any clip to be keyed in Ultra (that is, against a green or blue 
background).

2. Open the clip in its own session, and key it as usual.

3. Save the clip with the following settings on the Output tab:

Format: DirectShow AVI
Codec: Uncompressed
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32 bit AVI with Alpha
4. The clip is in the Output Clips folder, or the path that you set for it. Assign the clip to the 

overlay as you would any source.

5. Proceed with any resizing, repositioning, and so on.

Finished, composited scene
The following is an example of what the finished, composited scene looks like.

This example illustrates a common problem that ruins the illusion of the composited scene. 
The subject’s toes are in a position where the overlay does not cover them. You have several 
options for remedying the problem:

Include the area within the pink circle as part of the overlay image. 
Use the Mask Painter to make that region of the input clip transparent. For more 
information, see “Cropping and spot masking the source clip” on page 83.
Reposition the subject a few pixels to the left. For more information, see “Changing the 
position and scale of a layer plane” on page 92. 
Depending on the scene and where the subject walks, you may also be able to use the 
Input Cropping controls. For more information, see “Cropping the edge of a frame” 
on page 84.

T
IP If you’re working with a photographic image, a quick way to isolate the image with alpha 

all around is to shoot it against a greenscreen and then delete that background in 
Photoshop.
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If you want to have two or more objects in the foreground, you can put them in a single 
image. Be aware, however, that they will move as a unit if you change their size, position, 
or orientation.
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If the overlay covers part of the subject that should be in front and repositioning is not an 
option, then you may need to split the scene in two, and delete or adapt the overlay in the 
second part. For example, assume that there’s a doorway behind the subject and the area from 
the door frame to the left is part of the overlay to create the illusion that the subject is entering 
the scene through that door. It's likely that the subject’s right hand would be behind the 
overlay when gesturing. For instructions on getting around this type of situation, see 
“Advanced compositing tasks” on page 72.

Advanced compositing tasks
You may want or need to have an element in the foreground in one segment of a scene but in 
the background in another segment. Moving all or part of an image from the foreground to 
the background, or vice versa, can help you to get the subject on the correct side of a wall, 
doorway, or pillar. This can also help create the illusion of dimension within the scene.

All of the overlays in a particular session are always in front of the subject. However, you can 
achieve this illusion of dimension by breaking the scene into two or more sessions. You can 
then use the same input clip in each session, trimming it appropriately by setting the In point 
and Out point so that the segments blend seamlessly. You should break the sessions at a 
timepoint where the subject is not in front of or behind the element that is swapping layers. 
For more information, see “Trimming the In and Out Points in a video clip” on page 104.

The images below represent a three-part scene.

Trim times Overlay Composited shot

In Point: 0:00.00
Out Point: 0:10.00
72 How to



Because saving clips in Ultra is fast, particularly if you use the GPU Boost feature, you may 
find it quicker to render the complete scene multiple times—once with each overlay—and 
then use an NLE to cut from one scene to the next. This achieves the same result without 
having to create multiple sessions in Ultra and trim the input clip precisely in each session. 
Which workflow is faster depends on the speed of the computer, the size of the scene, and 
other factors.

If you reposition the overlay in one session, then when you merge an object from the overlay 
into the background for another session, you will have to move the object to the same relative 
position. Otherwise, the object will appear to move when you cut from one session to the 
next. If you left the element in the background when you copied it for an overlay, then you'll 
have to reposition the element in the foreground and background for the same session or else 
they'll be out of registration.

For more information, see “Positioning insets in custom virtual sets” on page 94.

Customizing a virtual set
You can modify a virtual set by changing the color, size, orientation, and other parameters in 
Ultra, or you can use an image-editing application to redesign any or all of an image.

In Point: 0:10.01
Out Point: 0:20.00

In Point: 0:20.01
Out Point: 0:40.00

Trim times Overlay Composited shot
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Editing virtual set images
The source files that make up the layers of a static virtual set are .jpg and .png files that you 
can modify in any image-editing application. However, you cannot edit VirtualTrak sets. If 
you are using any VirtualTrak shots, then before you change a set, you should storyboard all of 
the scenes in a given master set and avoid editing any static views that are visible in the 
VirtualTrak shots. This avoids breaking the continuity of the scene.

A virtual set has one or more image source files that are normally hidden. To determine the 
names of the files that you want to revise:

1. Load the desired virtual set.

2. Switch from the standard set of thumbnail controls for User-Defined sources to those for 
the Pre-Defined sources for virtual sets by choosing View > Displayed Inputs > PreDefined 
or by pressing Alt+P. The top thumbnail is for the virtual set just as it is for the standard 
controls. Below it is a thumbnail for each layer in the set. ( To return to the standard set of 
layer thumbnails, choose View > Displayed Inputs > User-Defined or press Alt+U.)

3. Click the thumbnail for the layer that you want to modify.

4. Check the Current Source field below the Input Preview Monitor to find the name of its 
source file. You can check the full path in the Look In field of the dialog box that appears 
when you click the Browse button.

The files that you just identified are stored in the Elements folder in the Master Set folder for 
the selected virtual set.

1. Browse to where the virtual sets are stored. The default path is C:\Program 
Files\Adobe\Adobe Ultra CS3\Content\Virtual Sets\[Master Set name].

2. If you want to keep a version of the Master Set in its original form, copy its entire folder.

3. If you don’t see the Elements folder in the Master Set folder, choose Tools > File Options 
in Windows Explorer, click the View tab, and then select Show Hidden Files And Folders.

4. If you did not copy the entire Master Set folder, then Adobe recommends that you either 
make a copy of the Elements folder before starting to edit any images, or save the changes 
by a new name. Failure to do so could necessitate reinstalling the Master Sets Library to 
return to the original images for the virtual sets.

After you access the Elements folder, the .png and .jpg files are available for you to open and 
edit in an image-editing application.
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The licensing agreement for Ultra prohibits the resale of modified virtual sets and assets. 
In other words, you are not permitted to change the color or the value of some other 
property of virtual sets and then post the content for sale as original content. The license 
allows users to change the image slightly for their own productions.
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How you incorporate customized graphics into an Ultra session depends on whether you save 
the revised graphics by their original file names or by new names. If you used the existing file 
names, then assigning the associated virtual set loads the images. If you saved with new file 
names to preserve the original image files, then you must assign the new sources through 
Ultra as follows:

1. Assign the appropriate virtual set.

2. Switch to the Pre-Defined Sources view (Alt+P).

3. Select the thumbnail for a layer that you want to change to your version of the image.

4. Assign the desired image source as you would any other source. For more information, see 
“Assigning content to layers” on page 63.

Moving virtual sets to an alternate location
When you install a Master Sets Library, it is automatically stored in the same place that you 
installed Ultra. By default, the path is C:\Program Files\Adobe\Adobe Ultra 
CS3\Content\Virtual Sets\. After the installation, you can move some or all of the virtual sets 
to an alternate drive.

Moving a Master Set or the complete Virtual Set Library is the same as moving any folder 
using Windows Explorer or your preferred file management utility.

Copying a single virtual set
Copying a single virtual set is problematic because the component graphics for all of the sets 
in a Master Set are in a single, central folder. Therefore, you must isolate the files that are 
associated with the particular virtual set that you want to copy. Because some graphics are 
used in two or more virtual sets, it is important that you copy, not move, files in this 
operation.

1. Switch from the standard set of thumbnail controls for User-Defined Sources to those for 
the Pre-Defined sources for virtual sets by choosing View > Displayed Inputs > Pre-
Defined or by pressing Alt+P. The top thumbnail is for the virtual set just as it is for the 
other set of controls. Below it is a thumbnail for each layer in the set.

2. Click each thumbnail, and check the Current Source field below the Input Preview 
Monitor to find the name of its source file. You can check the full path in the Look In field 
of the dialog box that appears when you click the Browse button.

3. In Windows Explorer, browse to the appropriate folder for the Master Set, and copy the 
.mfx files for the desired virtual sets.
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4. Open another Windows Explorer window, browse to the location where you want to save 
a copy of this virtual set, and create a folder with a name of your choice.

5. Paste the .mfx files into the new folder.

6. Create a subfolder within the new folder called Elements.

7. Return to the first Explorer window, and look for an Elements folder. If you don’t see it, 
choose Tools > File Options, click the View tab, and then enable the Show Hidden Files 
and Folders option.

8. Open the Elements folder, and copy all of the files associated with the desired virtual sets.

9. Paste these files into the Elements folder that you created in the second Explorer window.

Setting the key
Ultra is a professional-grade keying tool capable of producing outstanding compositing 
results, making excellent background replacement possible with minimal effort. Because of 
the vector processing that Ultra performs, you can achieve excellent results even with source 
video that is less than perfect.

Ultra provides three methods of setting the key. The method that you should use depends on 
several factors. The following procedure should help you determine the method to use and 
whether additional manual refinements are necessary. 

1. If the color of the background is not well saturated, first enhance the color of the 
background.

2. If there is at least one frame with just the background, use the Set Key Method. If not, 
continue to Step 3.

3. If the color of the background is very consistent, use the Single Key Point method. If the 
color is not consistent, use the Multiple Key Points method.

4. After applying the appropriate keying method, fine-tune the key if necessary.

Keying methods
Set Key Method: This method produces the best results and is also the easiest to execute. 
However, you must have at least one frame in which only the background is visible. For 
more information, see “Set Key” on page 78.
Single Key Point Method (One Color Pickup): This method works well with backgrounds 
that have a consistent, saturated shade of green or blue. For more information, see “Single 
Key Point Method (One Color Pickup)” on page 79.
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Multiple Key Points Method (Color Spread): If you don’t have a frame with only the 
background visible and the color, brightness, and saturation of the background are not 
consistent throughout the frame, then use this method to create the chroma key map. To 
preserve shadows from the input clip, you also set multiple key points. For more 
information, see “Multiple Key Points Method (Color Spread)” on page 80.

If you have a video card that supports Pixel Shader 2.0, Ultra provides a feature that 
substantially accelerates how fast the system keys and composites a clip during a preview and 
in the course of saving output movies. Ultra can use the graphics processing unit (GPU), 
which greatly reduces the load on the CPU. To take advantage of this advanced capability, 
enable GPU Boost on the Keyer tab. 

Adobe recommends the following models of graphics cards or better:

Improving a background in the input clip
If the background of the input clip that you are working with is washed out to such a degree 
that you can’t get a decent key, you can use the Pre-Processing controls on the Colors tab to 
improve the quality. You may not recognize this problem until you’ve tried unsuccessfully to 
get a good key. After you become familiar with what you can accomplish with the keyer, you’ll 
know at a glance when color adjustments are necessary.

1. Select Pre-Processing on the Colors tab, and select Enable.

2. Increase the Saturation setting. This makes the background more keyable, but it also causes 
problems with the colors in the subject.

3. Proceed with keying the clip as normal.

4. Select Post-Processing on the Colors tab, and select Enable.

5. Reduce the Saturation setting to achieve a natural look.

Make SD video HD video

ATI Radeon 9600 Radeon 9800

NVIDIA GeForce FX 5700 GeForce 6 Series 6600

T
IP Although you may be able to rescue an otherwise problematic clip by changing the color, 

you should consider this your last resort, because it tends to produce artifacts and it 
involves more work. The results are better if the background in the input clip is well 
saturated and well lit to begin with. If you have any influence on the filming process, do 
whatever you can at that stage to capture footage that will be easier to key properly in 
Ultra. If you’re not sure what it takes to achieve high-quality footage, see “Shooting 
video for Ultra” on page 57.
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Set Key
Set Key is the recommended means for keying, not only because it produces the best results, 
but also because it’s easiest. At the click of a button, Ultra analyzes the entire frame and 
generates a mathematical model that it uses to key out the background for the session.

To use this method, the clip must have at least one reference frame, which is a frame that 
shows only the color screen background with nothing in the foreground. The frame can have 
areas beyond the edges of the color screen, because you will mask them out later.

The reference frame does not actually have to be from the input clip that you will be 
compositing. The most important thing is that the lighting, framing, and state of the 
backdrop for the reference frame and the actual input clip are identical. As long as none of 
these factors are different, the reference frame can come from another clip. If conditions on 
the set are static and reasonably under your control, you could shoot one clip to provide the 
reference frame for multiple clips with the same framing. If, however, any elements change—
for example, a wrinkle in the backdrop appears, disappears, or migrates a few inches—then 
you need a new reference frame for subsequent input clips.

To use the Set Key method, assign the clip containing a reference frame as the input clip and 
drag the preview slider to a reference frame. Then click the Set Key button. You don’t have to 
select Enable first, because the Set Key button automatically enables the keyer.

The background should disappear to reveal the checkerboard in the Input Preview Monitor 
and the current background in the Output Preview Monitor. Also, the button changes from 
Set Key to Apply Points.

If the actual input clip is not loaded, assign it in place of the reference clip. Drag the preview 
slider through the session with the virtual set or background assigned, looking for points 
where the key is less than ideal. If you find any, then you must fine-tune the key. For more 
information, see “Fine-tuning the Keyer settings” on page 84.
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If you're seeing a ghost image, then you probably clicked the Set Key button with the 
subject in the frame. This method works only when the frame is free of anything in the 
foreground.
To resolve this problem, either drag the preview slider to a show clear reference frame 
and click Set Key again, deselect Enable on the Keyer tab, or use one of the Key Point 
methods. For more information, see “Setting Key Points (Apply Points Method)” 
on page 79.
The Set Key Method works only if the framing of the camera remains constant 
throughout the shot. This means no zooming in or out, no panning or tilting, no moving 
boom or dolly shots, and no handheld camera. If you want these types of results, keep in 
mind that you can accomplish them in Ultra by using virtual camera moves. For more 
information, see “Panning and zooming” on page 99.
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Setting Key Points (Apply Points Method)
Ultra provides two methods for setting the key using key points that you select. In general, 
you should only need to use one of these methods if you do not have a reference frame that 
shows only the color screen background with nothing in the foreground. If the background is 
a consistent, saturated shade of green or blue, then you should use the Single Key Point 
method. For more information, see “Single Key Point Method (One Color Pickup)” 
on page 79. If the color, brightness, and saturation of the background are not consistent 
throughout the frame, then you should use the Multiple Key Points method. For more 
information, see “Multiple Key Points Method (Color Spread)” on page 80.

Single Key Point Method (One Color Pickup)
You should use this method if you do not have a reference frame for the input clip and the 
keying background is well lit and consistent in color with no pronounced shadows or uneven 
shading. For more information, see “Set Key” on page 78. If this is not the case for the current 
session, see “Setting the key” on page 76 to determine which of the other two methods to use 
to set the key.

Unlike the other methods of setting the key, this method does not use a mathematical model. 
Instead, this method samples a single color and subtracts that from the entire image, hence 
the name One Color Pickup for the keying method.

To set the key

1. With the input clip as the active layer, click the Add Key Point tool  below the Input 
Preview Monitor. If this tool’s icon is not displayed, then the input clip is not the active 
layer.

2. Click a single spot in the background to set the key point. Because the background should 
be a consistent color if you’re using this method, it doesn’t matter where you set the key 
point. If there are minor irregularities in the background, don’t set the key point near them.

3. Click the Apply Points button or press Ctrl+K.

4. If necessary, fine-tune the key. For more information, see “Fine-tuning the Keyer settings” 
on page 84.
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Although the background should be consistent, it doesn’t need to be exactly the same. Despite 
the slight vertical imperfections in the upper-left corner and a bit of variation in color, the 
frame in the following example is good enough to use for the One Color Pickup method. 
Using multiple points in this case would not significantly improve the quality of the key.

Multiple Key Points Method (Color Spread)
You should use this method in the following situations:

You do not have a reference frame for the input clip and the keying background is not a 
consistent color. For more information, see “Set Key” on page 78.
You want to preserve the shadows from the input clip. For more information, see 
“Keeping the shadow in an input clip” on page 82.

If neither of these conditions apply for the current session, then see “Setting the key” 
on page 76 to determine which of the other two methods to use to set the key.

Whenever you apply two or more points, Ultra generates a mathematical model based on the 
differences between the points. For a background without pronounced discontinuities, three 
to five key points are normally sufficient, and their exact position is not critical. Backgrounds 
with problem areas, such as folds in the backdrop or corners where a wall meets the floor or 
another wall, will require more key points and greater care in positioning them.

To set key points for backgrounds with gradual gradients

1. With the input clip as the active layer, click the Add Key Point tool  below the Input 
Preview Monitor. If this tool’s icon is not displayed, then the input clip is not the active 
layer.
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2. Look for pools of darker and brighter screen color (blue or green) in the background, and 
click once in each of these regions to set the key points. In a dark pool, the key point should 
be where it’s darkest. If there’s a hotspot, the point should be where it’s brightest. In the 
following example, the point in the lower-left corner and the two points on the far right 
side are for the three dark areas. The one next to the subject’s head is for the whole center 
of the background, which is well saturated. The key point in the shadow causes the shadow 
to be keyed out. If you want to preserve the shadow, do not set any key points there.

3. Click the Apply Points button on the Keyer tab or press Ctrl+K.

4. If necessary, fine-tune the key. For more information, see “Fine-tuning the Keyer settings” 
on page 84.

To set key points for backgrounds with hard shadows

If the background has any distinct discontinuities in color or brightness, which often result 
from folds or deep wrinkles in the background or from angles where a wall meets the floor or 
another wall, then you must set key points along both sides of the discontinuity as shown in 
the following example.
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In these cases, you’ll achieve the best results if the key points are very close to the problem 
area, but not on top of it. To get a better look at what you’re doing and have greater precision 
in positioning points, try magnifying the view of the Input Preview Monitor. For more 
information, see “Input area and Input Preview Monitor” on page 28.

Keeping the shadow in an input clip
A semitransparent shadow cast behind or below the subject can increase the realism of a 
composited shot. To preserve shadows from the input clip, use the Multiple Key Point 
method and take care not to position a key point within the shadow, as shown in the 
following example. For more information, see “Multiple Key Points Method (Color Spread)” 
on page 80.

To change how pronounced the shadow is, adjust the Shadows slider in the Matte 
Generation area on the Keyer tab.
To eliminate any residual color from the screen (green or blue) from the shadow, increase 
Start Level.
Do not change the Shrink Matte setting, because it weakens the shadow and leaves 
artifacts.

T
IP For a part of a problem area that the subject never passes in front of, masking the area 

generally produces better results. For more information, see “Cropping and spot 
masking the source clip” on page 83.

N
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To delete the last point you added, press Ctrl+Z. To delete all of the points, click the Clear 
Points button on the Keyer tab, or press Ctrl+E.
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Cropping and spot masking the source clip
If the image in the input clip extends beyond the edge of the color screen, shows any 
unwanted objects such as a light stand or boom microphone, or has harsh shadows or wrinkles 
that can’t be keyed out, then you can use a regional mask. This is often referred to as garbage 
matting.

Unlike color keying (chroma keying), which makes certain colors transparent or 
semitransparent, regional masking makes certain areas of the frame totally transparent 
regardless of the content’s colors.

Ultra provides two methods for applying regional masks. Use the Input Cropping controls on 
the Input tab to block out areas on the edges of the frame. Use the Mask Painter tool to mask 
out spots anywhere in the frame.

Both methods leave a sharp edge of transparency that can remain apparent after keying, 
particularly if the background had any shadows or wrinkles that spanned the masked region. 
To blur these lines so that they are less obvious, adjust the Edge Softness slider at the bottom 
of the Input Cropping control set.
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If you’re not satisfied with the real shadow, try a digital shadow. For more information, 
see “Adding shadows and reflections” on page 111.
Digital shadows have the following advantages over real shadows:
• There’s no special keying involved.
• You can position digital shadows wherever you want.
• You have more control over the appearance of the shadow.
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 Regional masks remain in a fixed position throughout the session. However, the chroma 
key adjusts dynamically to the movement of the camera and the subject. Preview the full 
clip to ensure that no masked areas are cut off or holes through the subject are left.

T
IP  In some sessions, masking can introduce space that makes it look like the subject is 

appearing from thin air rather than entering the frame from behind a foreground element 
as intended. To remedy this problem, move the input clip, which eliminates the need to 
crop the side. For more information, see “Moving and flipping the input vertically and 
horizontally” on page 97.
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Cropping the edge of a frame
The Input Cropping controls on the Input tab provide a quick method for masking off an 
entire edge of the frame, making the affected area of the input clip fully transparent. To crop 
an edge, drag the appropriate side of the blue-gray box with the corner and midpoint nodes in 
the Input Cropping control group. In this control, the black rectangle that’s revealed when 
you crop an edge represents the borders of the source. The Output Preview Monitor instantly 
reflects this change.

Painting a mask
The Mask Painter lets you cut transparent holes in the input clip wherever you choose.

1. Click the Mask Painter button  below the Input Preview Monitor. If this button is not 
displayed, then the input clip is not selected.

2. Drag in the Input Preview Monitor across the area that you want to mask out. The pointer 
appears as a black circle. The Input Preview Monitor and Output Preview Monitor 
instantly reflect the change. Zooming in the Input Preview Monitor gives you finer control.

Removing a spot mask

If you cut a regional mask that’s too large, you can trim it back with the Mask Eraser tool. 
Activate the Mask Eraser tool , and drag in the Input Preview Monitor to paint an area 
back to opacity. This tool works only with regions masked using the Mask Painter, not on 
areas along the edges that were cropped.

Fine-tuning the Keyer settings
If an input clip has a washed out or inconsistent background color, a tricky subject, or other 
keying challenges, you must manually change the input clip to get the results you expect. 
Even some high-quality input clips may require more than clicking the Set Key button to 
yield a key that is acceptable. This section covers the steps to achieving the absolute best 
possible results from the video. For more information about the controls on the Keyer tab, see 
“Keyer tab” on page 35.
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 If you’re painting or erasing the input clip after setting the key, the masked area is 
essentially invisible. To see the painted mask, disable the keyer by selecting Enable on 
the Keyer tab. This is particularly useful when erasing a mask so that you can see better 
where you need to erase.
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Viewing the key
The first step in fine-tuning the keyer settings is to see what the key looks like. Two measures 
that will help you see the key better are zooming in on a trouble spots and switching to a 
neutral background. For information on panning and zooming the view in the monitor, see 
“Magnifying and repositioning the view in the monitors” on page 33.

Switching backgrounds

Switching temporarily to a pure white, pure black, or checkerboard background can help you 
detect and eliminate imperfections in the key. For your convenience, these useful backgrounds 
are built into the Background layer thumbnail. Right-click the Background layer thumbnail, 
and try the different options to see which one best reveals various problems. In general, black 
and white work help you check the key along the edges and isolate imperfections in the input 
clip’s background, and the checkerboard backdrop helps you detect an unwanted 
transparency.

To change back to the desired background when you’re finished changing the keyer settings, 
right-click the Background thumbnail, and choose Reassign Last Source to retrieve the 
original image.

Basic keying workflows
This section suggests a sequence of steps to fine-tune a key. The order of the steps is important 
because various settings on the Keyer tab interact with one another. Proceeding in a different 
order may result in taking one step forward in one regard, only to find that you’ve moved back 
two steps in another regard.
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For most keyed scenes, a pure white or black test background represents the most 
challenging possible keying situation. You can use these backgrounds to tune the key 
more precisely than you can with an actual background. However, trying to eliminate all 
of the shading or noise in the video can be a frustrating and impossible challenge and 
can actually yield less appealing results than leaving the key a bit less than perfect. This 
is because achieving a perfect key can require extreme settings that reduce the quality of 
the overall appearance. For example, removing the last hint of green in the subject’s hair 
can result in a loss of definition along the edges.
When viewed against a real-world background, minor flaws in the key are usually not 
visible. Therefore, Adobe recommends that you use the white and black test 
backgrounds only for broad changes, and then use the actual background over which 
the clip will be composited to fine-tune the settings. If you later change the background, 
you may need to readjust the key.
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Keep in mind that each step in the process moves you closer to the goal of a convincing key, so 
don’t try to accomplish too much with any given adjustment. After performing these steps a 
few times, you’ll learn how the later steps build on the earlier ones. This sense of the whole 
process will serve you well in developing a feel for how much to change each setting during 
the process.

This fine-tuning process begins after you use one of the methods discussed in previous 
sections to set the key. If you’re satisfied with the key, then you don’t need to proceed with the 
following steps. 

This procedure assumes that the color screen is green, but these steps are the same for a 
bluescreen.

1. Click the Keyer tab. If the controls are disabled, click the Input Clip layer thumbnail.

2. Move the Transparency and Desaturation sliders all the way to the left (0.000), and move 
the Spill Suppression slider all the way to the right (1.000).

3. Increase Start Level in the Color Control area until most of the background is keyed out, 
but a green halo remains around the subject. It’s okay if a little green remains elsewhere in 
the background.

A) Green halo  B) Green remnants
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4. Increase Desaturation so that all of the remaining green turns magenta, but not so far that 
the magenta bleeds onto the subject. If you’re working with a bluescreen, the blue remnants 
turn yellow.

A) Halo turned magenta.  B) Desaturation went too far; magenta bleeding onto subject.

5. Decrease Spill Suppression until the magenta or yellow highlights are gone, but not so far 
that any of the green spill returns.

6. Set Start Threshold to the same value as Start Level, and set Transparency to the same value 
as Desaturation. This should produce a reasonably good overall result.

a. If the subject has any transparency in both dark and bright areas, then reduce the 
Transparency setting.

b. If only bright areas of the subject are partially transparent, then increase the Highlights 
setting.

c. If only dark areas remain somewhat transparent, then increase the Shadows setting.
7. If the input clip was captured from an analog source and contains a troublesome green or 

blue edge around the subject that you cannot eliminate by using the Color Control steps, 
then adjusting the Sensitivity setting may resolve the issue. This control can also help 
eliminate any green remaining in dark shadows. Increasing this setting makes the keyer 
include a wider range of colors, which means that it’s less sensitive or selective in what 
colors are keyed out. Clips that are well lit with a good background should not require any 
change to this setting. So if you find that you need to change the Sensitivity for many of 
the clips, then you should work on the setup in the studio to eliminate dark shadows below 
and behind the subject.

8. If the edges of the subject are jagged, change the Post-Processing controls, particularly the 
Soften Matte and Sharpen Matte settings. The Soften Matte setting smooths jagged edges, 
but makes them blurry. The Sharpen Matte setting removes some of the blurriness, leaving 
a crisper, smoother edge.
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You should only change these settings as a last resort. These settings change how Ultra 
defines the edges of the matte. Although changing these settings can resolve some issues, 
they also tend to cause subtle parts of the subject, such as hair and transparent objects, to 
disappear. As with the Sensitivity, Color Curve, and Alpha Curve controls, if you need to 
change the Post-Processing settings, there may be a problem that you can resolve in future 
clips by improving the lighting and setup. To learn more about how each slider affects the 
key, see “Keyer tab” on page 35. You may also want to check out the keying tutorials 
available on the Ultra support website: www.adobe.com/support/ultra.
If you are preserving the shadow in the input clip, do not change the Shrink Matte setting, 
because it weakens the shadow and leaves artifacts.

Saving and applying Keyer settings
You can save a profile of all of the settings on the Keyer tab and apply it to other sessions. You 
can also use this feature within a given session to preserve a particular set of settings before 
making changes, and then easily return to them if you don’t like the results of the changes. 
The profile encompasses only the Keyer slider settings; it does not include the mathematical 
model that’s created when you click Set Key or Apply Points.

To create a profile, click the Save button in the lower-left corner of the Keyer tab. A 
standard Windows Save As dialog box appears. The default path is My Documents\Adobe 
Ultra CS3\My Settings. The profile’s extension is .cks.
To apply an existing profile to the current session, set the key, click the Load button, 
browse to the correct folder if necessary, and then select the desired profile.

Positioning layers and performing virtual 
camera moves
This section describes how to move and scale layers and provides instructions for panning and 
zooming within a session.
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Differences between sets of Position controls
The Position controls on the Scene tab are for moving the active layer within the 3D 
environment. The Position controls on the Input tab are for moving the input source within 
its two-dimensional layer.

A) The Position In Scene controls in the Scene tab move the layer within the full frame. 
B) The Input Offset controls in the Input tab position and scale input within the layer plane.

The Position In Scene controls on the Scene tab let you move and scale the layer anywhere 
within the full frame or beyond the edges of the frame. This set of controls and the 
Orientation In Scene controls collectively define the size, position, and orientation of the 
layer plane, or the space within which the layer’s input appears. Unlike a plane in broad 
geometrical terms that extends to infinity in both dimensions, a layer plane in Ultra has 
defined borders. The Input Offset controls on the Input tab function only to position and 
scale the image within the borders of the layer plane.

As a rule, you should use the Input Position and Input Orientation controls whenever possible 
to achieve the desired composition because they provide greater control and they’re not 
hardware-dependent.

To prevent moving images out of their necessary position, these settings are locked for insets 
in the background of virtual sets and the input clip in VirtualTrak shots. In these cases, correct 
the layer’s position with the Input Offset controls. Because the offset is hardware-dependent, 
some video cards do not fully support this functionality.
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Adjusting the framing
The Position In Scene and Input Offset controls are only two methods for controlling the 
scale of images or the framing of what’s displayed in the Output Preview Monitor. If what you 
see in the monitor is not what you expect, check the settings described in the following table.

Control Tab Description

Position In Scene Scene Controls the size and position of the layer 
plane. See “Changing the position and scale 
of a layer plane” on page 92.

Orientation In Scene Scene Controls the perspective of the layer plane in 
all three axes. See “Changing the orientation 
of a layer plane” on page 93.

Size In Scene Scene Controls the scale of layer plane 
independent of the Z setting in the Position 
In Scene controls. You can scale the layer 
plane of the input clip in sets that lock the 
other Scene controls. See “Rescaling the 
input clip’s layer plane in a virtual set” 
on page 92.

Input Offset Input Controls the size and position of the image 
on the layer plane. See “Moving and scaling 
an input within the layer plane: Input Offset 
controls” on page 95.

Pan and Zoom Pan & Zoom Controls the region of the composited scene 
that is shown for every frame of the exported 
clip. See “Panning and zooming” 
on page 99.

Pan and Zoom Output Preview 
Monitor

Controls the region of the scene that is 
shown in the monitor. This affects only what 
you see within Ultra. It has no effect on 
what’s exported. See “Magnifying and 
repositioning the view in the monitors” 
on page 33.
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Setting the size, position, and orientation of a layer 
plane
The Scene tab contains the controls for changing the size, position, or orientation of a layer. 
Changing the scale and position of the input clip and other layers is a basic step in the typical 
workflow for setting up a session. Although you may also change a layer’s perspective during 
that process, you’re more likely to use the orientation controls when building your own set. 
For more information, see “Creating elements for a set or individual layers” on page 68. The 
settings in these two controls collectively define the layer plane, which limits the range of 
motion possible through the Input Offset control. For more information, see “Differences 
between sets of Position controls” on page 89. If you’re not familiar with how repositioning a 
layer with the Position In Scene controls on the Scene tab differs from moving a layer with the 
Input Offset controls on the Input tab, see “Positioning layers and performing virtual camera 
moves” on page 88.

The Pause Point Settings control defines the length of a pause in a VirtualTrak shot. For more 
information, see “Setting a pause point for a VirtualTrak effect” on page 107.

T
IP For fine control of the changes, Alt-drag. This refines the response by a factor of 10.
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For an input clip in a VirtualTrak set, Ultra locks the controls for changing the size, 
position, and orientation because the subject’s position is essential to making the input 
clip work. These controls are also frozen for all of the insets in any virtual set because the 
alpha regions in the background dictate the position of these subbackground graphics. 
Use the Size In Scene slider to change the scale of the layer plane for the input clip or 
any other layer if the subject looks too small or large in relation to the scene.
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Changing the position and scale of a layer plane

A) Y axis - Vertical position: Drag vertically.  B) Z axis - Scale: Shift-drag vertically. 
C) X axis - Horizontal position: Drag horizontally.

The Position In Scene control sets the position and the size of the layer. Before repositioning 
the input clip, find the spot where the current position is most problematic, determine the 
direction and distance that you need to move the layer, and then drag the preview slider 
through the segment, looking for places that may be adversely affected by the new location. 
With insets in a custom virtual set, the correct position and orientation are essentially defined 
by where you cut the transparent holes in the background. For more information about 
moving and scaling these layers, see “Positioning insets in custom virtual sets” on page 94.

To move the layer right and left along the x axis, drag the Position grid sideways, or enter 
a value in the X field.
To move the layer vertically along the y axis, drag up and down, or enter a value in the Y 
field.
To shrink or enlarge the layer, Shift-drag up or down, or enter a value in the Z field.

The right-click menu for the grid control provides options for resetting values individually or 
collectively.

Rescaling the input clip’s layer plane in a virtual set

Use the Size In Scene slider if a virtual set’s predefined layer plane for the input clip is too 
small to show the subject correctly scaled to the set. This slider is in the lower-left corner of 
the Scene tab. The Size In Scene slider lets you shrink or enlarge the layer plane for the input 
clip or whichever layer is selected.
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Unlike changing the scale by using the Position In Scene grid control, which works relative to 
the absolute center of the layer plane, adjusting this slider works relative to the middle of the 
plane’s bottom border. This means that the subject shrinks and grows from the ground up 
rather than from the center out. Of course, in a wide shot where you can see the subject from 
head to foot, the position of the subject’s feet probably changes to a degree because there’s 
generally some greenscreen below the feet. If necessary, you can counter this upward creep by 
moving the subject down with the Input Offset control. For more information, see “Moving 
and scaling an input within the layer plane: Input Offset controls” on page 95.

The Size In Scene slider is not restricted to virtual sets for which the Position In Scene 
controls are locked. In fact, when working with the virtual sets that you create, you may find 
this slider preferable to the grid control because it works from the ground up. Adobe 
recommends that you position the bottom of the layer plane as desired with the grid control, 
and then change the scale by using the Size In Scene slider

Changing the orientation of a layer plane
The Orientation In Scene control lets you rotate the plane of the image around the three axes. 
All three values work on a 360° scale (±180°).

A) Y axis - Rotate around the vertical axis: Drag sideways.  B) Z axis - Spin around the 
perpendicular axis (angle): Shift-drag vertically.  C) X axis - Rotate around the horizontal axis: 
Drag up and down.

To rotate the layer around a horizontal axis (that is, in the vertical plane), drag the 
Orientation grid up and down, or enter a value in the X field.
To rotate the layer around the vertical axis (that is, in the horizontal plane), drag sideways, 
or enter a value in the Y field.
To spin the layer on its center point (that is, rotate around the perpendicular axis), Shift-
drag up and down, or enter a value in the Z field.
Positioning layers and performing virtual camera moves 93



Dragging sideways in the Position In Scene control changes the X value, but changes the Y 
value in the Orientation In Scene control.

The right-click menu for the grid control provides options for resetting values individually or 
collectively and for rotating the plane in 90° increments on the perpendicular axis (Z).

Positioning insets in custom virtual sets
All of the custom sets (such as “Simple Keyed with B”) are in the Basic folder of the Virtual 
Sets library and are initially scaled to full frame. Although in special circumstances you may 
want to display an inset in full frame, you typically scale and position each inset to its correct 
location as defined by the transparent regions in the custom background. Adobe recommends 
the following workflow:

1. Assign the desired basic set and background. If necessary, change the size, scale, and 
orientation of the background.

You must use a background that has one or more transparent regions cut in it to show the 
sources behind it. For backgrounds that you use with one or more inset sources, you must 
create an alpha region in the graphic for each inset.

2. Click the inset’s thumbnail to make it the active layer. If the basic set has multiple insets, 
then Source B is selected by default.

3. Assign the desired source to the inset.

4. Reduce the scale to roughly the size of the transparent region in the background through 
which it will be seen. You probably can’t see the image in the Output Preview Monitor, so 
you must rely on the relative size of the grid in the Position In Scene control.

5. Change the position so that the image is centered in its transparent region.

6. Fine-tune the scale, orientation, and position to achieve the desired framing.

N
O

T
E

The orientation is relative to the center of the 3D space, which for virtual sets is often not 
the actual center of the frame. For example, you may expect that a Y value of 90° always 
shows the plane edge-on; however, this is only true if the 3D-center is centered on the 
frame in the horizontal dimension and the position is centered in that plane. If either the 
3D-center or the current position is off-center, then the layer has a dimension with the 
value set to 90°.
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Because of the interrelationship of the three coordinates, any given orientation can be 
defined by two sets of coordinates. As a result, Ultra may under certain circumstances 
change a set of values to a different set of values with identical results. For example, if all 
three values are zero and you enter 180 for Y, Ultra displays 180 for X, 0 for Y, and 180 
for Z.
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7. If the basic set has another inset layer, then select it through the list above the inset’s 
thumbnail and repeat steps 3 through 7 for that layer.

Moving and scaling an input within the layer plane: 
Input Offset controls
If you’re not familiar with how moving a layer with the Input Offset controls on the Input tab 
differs from repositioning a layer by using the Input Position In Scene controls on the Scene 
tab, see “Positioning layers and performing virtual camera moves” on page 88.

A) Black box represents the borders of the layer plane. Content outside this box is cropped. 
B) Y axis - Vertical position: Drag up and down.  C) Angle: Ctrl-drag vertically.  D) Scale: Shift-
drag vertically.  E) X axis - Horizontal position: Drag sideways.

Use the Input Offset controls, which are at the center of the Input tab, to move and scale the 
active layer within its layer plane. For more information, see “Differences between sets of 
Position controls” on page 89. In general, you should use these controls only when the Input 
Position In Scene controls on the Scene tab are locked for the layer, which they are for the 
input clip in a VirtualTrak set and for all insets (Source B, C, and so on) in all virtual sets.
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The black box in the Input Offset grid control represents the layer plane. It does not change 
to reflect the size or orientation that is set by using the controls on the Scene tab. If you 
change the Input Offset so that any part of the image lies beyond the black box (see the pink 
areas in the previous graphic), that part is cropped from the image. Conversely, any places 
where the edge of the grid is within the layer plane (see the checkerboard areas in the previous 
graphic) appear either transparent or black, depending on the set. The following graphic 
shows what would be displayed with the Input Offset settings from the previous example.

Given how these controls function within the layer plane, these controls are useful in the 
following situations:

Repositioning an input clip in a VirtualTrak scene. VirtualTrak sets lock the Input 
Position In Scene controls that you usually use for this purpose. These controls are 
particularly valuable in this regard if the input clip is a few pixels off so that the subject 
appears from the middle of space rather than emerging from behind a door, pillar, or other 
foreground element.
Zooming in on a part of the image by increasing the scale of the source and, if necessary, 
repositioning it for the desired framing.
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The Input Offset controls require hardware capabilities that not all video cards support. 
For those video cards, you may see artifacts around an image when it does not fill the 
layer plane. In some cases, cropping the edges slightly with the Input Cropping tool can 
delete the visible repeat. For more information, see “Cropping the edge of a frame” 
on page 84.
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Vertical, horizontal, and angular movement is relative to the native coordinates of the 
source. If you rotate the source or flip it in either dimension by using the position and 
orientation controls on the Scene tab, then the image’s motion seems contrary to the 
mouse’s movement.
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Moving and flipping the input vertically and horizontally
To move the input horizontally along the X axis, drag the Input Offset grid sideways, or 
enter a value in the X field.
To move the input vertically along the Y axis, drag the grid up and down, or enter a value 
in the Y field.
To flip an image so that subject who was looking to the left is now looking right, or vice 
versa, select Flip Horizontal below the grid control
To flip an image so that the top becomes the bottom, select Flip Vertical.

Rotating the input
To rotate the input around its center point, Ctrl-drag the Input Offset grid vertically, or enter 
a value in the Angle field. The scale for this field is 360° (±180°).

Turning the image 90° to display it in the portrait orientation

To rotate an image so that it is displayed in the portrait orientation rather than landscape, 
select Plus-90 (Portrait) below the grid control. This turns the layer 90° counterclockwise. If 
this leaves the image upside down, then select Flip Horizontal. Even though you’re correcting 
how the image is displayed vertically in the frame, you use Flip Horizontal rather than Flip 
Vertical because these controls work relative to the image’s native orientation.

T
IP If you’re working with a keyed input clip and want to see the size, position, and 

orientation of the input clip within the frame, try either disabling the keyer or switching to 
a solid image. The easiest way to do this is to right-click the Input Clip thumbnail, and 
then choose Assign White, Assign Black, or Assign Checkerboard. When you’re ready 
to see the keyed video against the background again, right-click the Input Clip 
thumbnail, and then choose Reassign Last Source.
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Changing the scale of the input
To shrink or enlarge the input, Shift-drag the Input Offset grid vertically, or enter a value in 
the Scale field.

Scaling an input source to fit the virtual set

If the aspect ratio of a source image or video does not match the aspect ratio for a session (4:3 
or 16:9, which is set by using the Output tab), then by default Ultra zooms to the center of 
the image so that it fills the frame, cropping either the sides or the top and bottom.

To scale the source so that the full image is displayed within the Output Preview Monitor, 
select Scale To Fit.

T
IP By turning a standard-definition clip sideways, you can use footage from a standard-

definition camera in a high-definition scene. What distinguishes HD from SD is the 
number of horizontal lines (scan lines, or rows of pixels) in the image. Since SD NTSC 
video is 720x480 in its regular landscape orientation, rotating the video to portrait mode 
produces 720 lines of resolution.
To create footage for use in an HD scene with an SD camera:

1. Shoot the input clips with the SD camera turned sideways.

2. Assign the resulting 720x480 clip to a 16:9 virtual set with a background that has at 
least 1280x720 resolution.

3. Enable the Plus-90 mode. This rotates the input clip 90°. If Scale To Fit is enabled—
which it is by default for the input clip—then the image also automatically shrinks so 
that it fits in the vertical dimension of the set. You can change the scale and position 
if necessary to achieve the desired composition.

4. When everything else about session is set as desired, save the output movie with the 
resolution set to 1280x720.

The advantage of shooting with an HD camera versus an SD camera turned on its side is 
that you have room for the subject to move around. But you also have something to gain 
by turning the camera sideways—1920 lines of video instead of 1280. If you zoom in on 
HD video in its normal landscape orientation, you will soon run into pixelation as the 
zoom ratio exceeds the 720 or 1080 lines. With the camera turned on its side, you can 
shoot footage that you can then zoom in on much more in Ultra without pixelation 
problems.

T
IP For fine control of changes to these grid controls, Alt-drag. This refines the response by 

a factor of 10.
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The right-click menu for the Input Offset grid control provides options for resetting 
values individually or collectively and performing common rotations, flips, and zooms.
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Returning all grid settings to the defaults
Clicking the Reset button returns all of the Input Offset values to the default settings. This 
action does not affect check boxes in this control group, such as Scale To Fit and Portrait.

Panning and zooming
Ultra lets you program complex virtual camera movements into a session to produce pans and 
zooms and also tilts, dolly shots, and boom maneuvers. If you’ve ever tried to capture such 
shots on film or tape, you know how tricky they can be. A take can be ruined by the slightest 
jiggle, and it sometimes seems impossible to maintain focus and framing through a camera 
move of any complexity. Ultra delivers the desired results with no such glitches and with 
precision down to the frame and the pixel.

You can program up to 64 pan and zoom points—though you may be better off editing 
simple scenes together with an NLE than designing a scene that’s this complex.

Each virtual camera move follows a straight line from one pan and zoom point to the next. If 
you want a movement to follow an arc, set multiple points that collectively form a curved 
path. The speed of a move is a function of the distance between the two points divided by the 
time between them. To make the moves smoother and more natural, the rate accelerates at the 
beginning and decelerates at the end. Adobe uses a Hermite spline to calculate the rate curve.

Grid control
The grid control on the Pan & Zoom tab sets the scale and position of each pan and zoom 
point. The following explains what the grid control displays and how it works.
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Ultra’s support for high-resolution graphics and HD video and its pan and zoom capacity 
lets you create some truly stunning results. Because Ultra maintains the resolution of still 
images up to 4096x4096 rather than automatically converting all graphics larger than 
720x480 to that resolution, all of those pixels are still there. (The maximum resolution for 
still graphics may be less, depending on the limitations of the graphics card.) When you 
zoom in and then zoom in further on a high-resolution image, the image remains crisp 
and unmarred by the blockiness or fuzziness that comes from enlarging low-resolution 
graphics.

T
IP When making spatial adjustments, you should start on the Scene tab if the virtual set 

permits changes there, and then proceed to the Input tab if necessary to finish with the 
Pan & Zoom settings. This is because the position of all of the layers and their sources 
must be finalized before programming the pan and zoom points.
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Visible frame: The black rectangle around the edge represents the visible frame, or the area 
that will be exported. This area remains stationary when you move the grid. The shape of 
this area is controlled by the setting for the aspect ratio of the session on the Output tab.
Scene: The blue-gray 4 x 4 grid represents the composited scene. The aspect ratio of the 
grid corresponds to the aspect ratio of the current set. The size and position of the grid 
change when you drag it or enter values in the X, Y, and Z fields.

The perimeter of the grid reliably represents the boundaries of the scene only if the following 
occur:

You’re using a virtual set from a Master Sets Library or the background for the Basic set is 
the same aspect ratio as the session
The scale of the background is set to 0.000 (1:1) on the Scene tab.
No other layers extend beyond edges of the background.

However, if you use the Scene tab to enlarge the scale of the background or another layer or if 
other layers are distributed beyond the background, then by definition there is content 
outside the grid. In that case, the grid display loses any meaningful context, so you must rely 
entirely on what’s shown in the Output Preview Monitor. The bottom line is that you can set 
pan and zoom points where the grid is entirely out of view in this control. If there’s content 
there, then it it’s visible. If there’s no content there, then all you see is solid black.
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To avoid breaking the context of the Pan & Zoom grid control, Adobe recommends that 
you do not increase the scale of a layer plane by using the Scene tab beyond the size of 
the visible frame unless there’s a good reason to do so. For example, you may want to 
enlarge a 4:3 image to fill a 16:9 frame or zoom in further during a virtual camera move 
than is possible with the layer plane’s scale at 1:1.
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A) Black box represents the borders of the publishing frame. Content beyond the box is cropped; area 
inside the box but beyond the grid may be blank.  B) Y axis - Vertical position: Drag up and down. 
C) Z axis - Scale: Shift-drag vertically.  D) X axis - Horizontal position: Drag sideways.

To pan right and left along the X axis, drag the grid sideways, or enter a value in the X 
field.
To pan up and down (that is, tilt the Y axis), drag up and down, or enter a value in the Y 
field.
To zoom in and out, Shift-drag up and down, or enter a value in the Z field. You cannot 
zoom out any farther than 1:1 (0.000).

The right-click menu for the grid control provides options for resetting values individually or 
collectively.

Adding and setting a pan and zoom point
1. Reset the Output Preview Monitor to full frame view by clicking the  button. Even if 

you’re certain that it already shows the full frame, it’s worth taking the time to click the 
button before setting any pan and zoom points. If the monitor is zoomed in when you set 
points, the final results may not be what you expect.

2. Enable panning and zooming by selecting Enable in the Pan & Zoom tab. When you first 
enable panning and zooming, two points are set by default—one in the first frame and the 
other point in the last frame.

3. Drag the preview slider to the frame where you want to set a pan and zoom point.
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For sessions that don’t contain video clips, you must set a duration for the input clip 
before you can preview the session and add pan and zoom points. Enter a time in the Out 
Point field on the Input tab. If you’re not certain exactly how long the session will be with 
the virtual camera moves, set a value higher than you expect to use, and then correct it 
after you program all of the camera moves.

4. Click the Add New Point button. A new entry is inserted in the appropriate order in the 
list of pan and zoom points.

5. Change the scale and position with the grid control. The Output Preview Monitor shows 
the pan and zoom position.

6. Repeat steps 3 through 5 for each additional point. To delete a pan and zoom point, select 
it in the list, and then click the Delete Current Point button.

Changing a pan and zoom point
To change the setting for an existing pan and zoom point, click its row in the list in the Pan & 
Zoom tab. The position and zoom settings change dynamically as you move the grid control 
or manually change the values in the X, Y, and Z fields. However, the time setting does not 
change dynamically when you select a point and preview the session, but rather requires a 
discrete step, either clicking the Set to Preview Time button, or typing a framecount in the 
Time field and pressing Enter.
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If the first, last, or both pan and zoom points are set to the session’s first and last frames, 
respectively, and you change the total length of the session, then the times for those 
points automatically change. The time setting for intermediate pan and zoom points, 
however, do not change if, for example, you trim the In point of the input clip after 
programming virtual camera moves. Therefore, Adobe recommends that you get the 
session’s timing settled before designing pan and zoom maneuvers.
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The Output Preview Monitor always shows the visible area for the current frame in the 
session. This means that if you drag the preview slider away from the frame for the 
currently selected pan and zoom point and then change the zoom and position settings, 
the monitor does not represent the new framing. You may see a change in the framing 
for the current timepoint, but that’s because changing a pan and zoom point affects the 
visible area for all of the frames between that point and the one on either side. To have 
the Output Preview Monitor show exactly where a pan and zoom point is, the current 
frame must precisely match the current pan and zoom point. To jump to that frame, 
deselect and reselect the current point.
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Programming a continuous virtual move with multiple points
To produce a continuous move that zigs and zags, follows an arc, or changes zoom direction 
rather than going straight from point A to point B, add a sequence of pan and zoom points, 
one at each position where you want the pan or zoom direction to change. The rate of 
movement is a function of distance over time. It is graduated at the start and end of each leg.

Programming multiple moves with pauses
To have the framing hold steady for a period of time between two moves, you must set two 
pan and zoom points for the same position. This type of sequence would look similar to the 
following:

Time A / Position 1
Time B / Position 2
Time C / Position 2
Time D / Position 3

The difference between Time B and Time C is how long the position remains unchanged.

Panning and zoom with different aspect ratios
If the frame aspect ratio for the session is 16:9 and the frame aspect ratio of the set is 4:3, then 
the correct Z setting to zoom in just enough to fill the frame laterally is -0.333. At this setting, 
you can change the Y value from 0.333 to -0.333 without any empty lines appearing at the 
top or bottom of the visible frame.

If the aspect ratio for the session is 4:3 and the aspect ratio for the set is 16:9, no such change 
is necessary because the vertical dimension of the scene is already scaled to fit the visible 
frame, and the sides of the scene extend beyond the edge of the frame.

These values assume that the scale of the layer plane is 1:1.

Viewing a session without virtual camera moves
If you programmed pan and zoom points, but want to view the session without panning and 
zooming, disable the feature by deselecting Enable.
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Achieving the correct timing for video 
clips
This section describes the tasks involved in achieving the correct timing of video clips.

Trimming the In and Out Points in a video clip
If a video clip contains any content at the beginning or end that you don’t want to include in 
the current session, you can trim the unwanted frames using the In Point or Out Point control 
on the Input tab. If the input clip has reference frames for keying purposes, this is how you 
can prevent them from showing in the output movie. You can also use these controls to cut a 
particular source clip into segments for a series of sessions that collectively produce an 
advanced compositing result in which the subject appears to be behind a graphical element at 
one point and in front of it at another point. 

The Input Preview Monitor shows the entire length of the source clip, but the Output 
Preview Monitor shows only the trimmed clip.

The In Point and Out Point settings are reset when you assign a different clip to the layer. If 
you intend to return to the original trimmed clip and want to reapply the same trim points, 
make sure that you note the timecodes before switching sources. 

The In and Out points do not affect the source clip. They are the timepoints where Ultra 
starts and stops playing the clip in the session.

For more information, see “Advanced compositing tasks” on page 72. For video clips that are 
assigned to a layer other than the input clip and are longer than it, you should trim them so 
that they end at the same time as the input clip.

The steps are the same regardless of whether you’re trimming the In Point or the Out Point.

1. In the Input Preview Monitor or Output Preview Monitor, drag the preview slider to show 
the frame that you want to trim.

2. To trim the content before the current position, click the Set button to the right of the In 
Point timecode field. To trim the content after the current position, click Set for the Out 
Point field. The time displayed at the lower left of the Input Preview Monitor is set as the 
timecode for the selected trim point, and the Trimmed Duration reading to the right of 
the trim point controls indicates the length of the clip based on the current settings.
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Looping the clip
You can set a video clip assigned to any layer to play in a loop for as long as the session runs. 
By default, all of the layers except the input clip are set to loop.

1. If the layer to which the video clip is assigned is not already the active layer, click its 
thumbnail to activate it.

2. Select Loop Source on the Input tab.

Specifying when a video clip begins playing in the 
session
The Offset Into Scene setting delays the start of a video clip by the specified time after the 
beginning of the session. Although you can delay the start time for any video clip in any layer 
of any type of virtual set, you will usually want to do this only in a session that uses a 
VirtualTrak effect. Achieving the correct timing for three points in the video is the most 
important task in setting up a VirtualTrak clip. Most VirtualTrak effects open with a virtual 
camera movement that takes several seconds to track, pan, or zoom to the plane where the 
input clip is displayed. You typically want to wait at least until the Virtual Trak effect brings 
that plane before having the input clip begin playing, and you may prefer to delay its start 
until the effect ends.
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To return the In Point setting to zero or the Out Point setting to the end of the clip, click 
the Reset button for the appropriate control.
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If you know the desired timecode, you can also type it directly into the field. In this case, 
do not click the Set button because it applies the current time.
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The trim controls are locked when the active layer is the background for a VirtualTrak 
set, which is a special type of animated clip.
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For a looped source to appear reasonably natural, the beginning and end must be such 
that the viewer will not notice when the clip restarts. If trimming the start or end point will 
help achieve this result, then the In Point and Out Point controls may be of use.
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You will rarely, if ever, want to loop the input clip, because it’s normally the longest 
source in the session. If you do encounter a situation where you want to loop the input 
clip, this option is also available for that layer. Looping the input clip will create an infinite 
loop. Ultra sets the end of a session by the longest nonlooping source to avoid an 
endless cycle.
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These instructions refer specifically to setting the Offset Into Scene time for a VirtualTrak 
effect, but the steps are essentially the same regardless of which layer a clip is on or what type 
of virtual set is assigned.

1. Create a session with a virtual set that has a VirtualTrak set and an input clip in which the 
subject walks into frame.

The name of a VirtualTrak set is followed by “(Trak)”. An example of a VirtualTrak set 
is the “Museum Intro (Trak)” set in the Virtual Sets\Museum library (from MSL1).
If you don’t have your own input clip handy, use “Suzy – Wide – Walk in Left”, which 
is in C:\Program Files\Adobe\Adobe Ultra CS3\Content\Sample Clips\NTSC Sample 
Clips.

2. In the Output Preview Monitor, drag the preview slider to the time when you want the clip 
to begin playing. For VirtualTrak effects, this is typically when the plane of the input clip 
appears or at some time shortly thereafter. If you’ve already keyed the input clip, disable 
the keyer so that you can see the plane appear.

3. Click the Set button for the Offset Into Scene setting on the Input tab. This applies the 
current framecount from the Output Preview Monitor to this field, delaying the playback 
of the input clip until this point in the session.

4. Reenable the keyer and play the session in the Output Preview Monitor again to assess the 
timing of the subject’s appearance. If the timing isn’t correct, then you probably need to 
trim the In point for the input clip as described in “Trimming the In and Out Points in a 
video clip” on page 104. For example, in the “Suzy – Wide – Walk in Left” clip, the subject 
doesn’t enter from the left until frame 17.

5. If the subject’s position isn’t correct relative to the virtual set, then you must change the 
position of the input. For more information, see “Moving and scaling an input within the 
layer plane: Input Offset controls” on page 95.
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If you want to try adjusting the timing for a VirtualTrak session using a clip that’s built into 
Ultra, see the tutorial titled “Adjusting Timing on a VirtualTrak set shot” at 
www.adobe.com/support/ultra.
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Setting a pause point for a VirtualTrak effect
Some VirtualTrak sets let you pause the effect so that the virtual camera move allows time for 
a video clip to play, subject to talk, or credits to roll. For example, in the “Library Book to 
Talent with Pause” set in the Master Sets Library 1 (MSL1), the camera starts with a tight shot 
on a book containing an inset Source B. If you insert a video in the Source B, you must 
program a pause time so that the camera waits the appropriate length of time before 
beginning the virtual pan to the location of the input clip. You may want to enter a pause time 
for a still image as well if you want the audience to have time to study it.

Ultra defines the Pause Begins At time; you specify the Pause Ends At time. Typically, it takes 
the following steps to accomplish this:

1. Select the correct Input Source.

2. In the Input Preview Monitor, drag the preview slider to the point where you want the 
virtual camera move to start or resume.

3. Click the Set button in the Pause Point Setting control area on the Scene tab. This applies 
the time from the Output Preview Monitor.

Adjusting the volume of a video clip
For any video clip that has an audio track, you can control the volume by selecting the correct 
layer and adjusting the Volume slider on the Input tab. This is particularly useful for 
eliminating ambient audio from a clip that you use as the source for any layer other than the 
input clip.

To mute the audio, move the slider all of the way to the left.

This setting affects the volume in the final output file and what you hear in Ultra.

Fine-tuning the appearance of the video
This section covers a variety of refinements that you can make in Ultra to put the finishing 
touches on a composited shot. These changes can make the difference between a scene that is 
merely effective and one that is truly convincing.

The following are changes you can make outside of Ultra to modify your video:
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Matching mixed media: If the input clips are DV that were compressed, but the 
background was shot on film, the two sources may not match perfectly. Typically, the film 
footage looks too clean compared to the subject. Since there’s no way to make the DV clip 
as clean as the film, you can compress the film clip in an NLE, such as Premiere Pro, using 
the same codec, or you can add noise using Adobe Premiere Pro.
Matching the audio to the virtual environment: In some situations, you may want to 
process the audio for a composited scene to make it sound like it was recorded in an 
environment similar to the virtual set in which the scene takes place. For example, if a 
scene is set in a large virtual cathedral, you may want to add some reverb to the actor’s 
voice. You can also change the reverb and equalizer settings to simulate relative 
microphone distance between tight shots and wide shots. You may also want to mix in 
subtle appropriate ambient sound effects, such as street noise or wind in the trees. You 
cannot change the audio in Ultra. You can use an application such as Adobe Audition or 
Soundbooth.

Correcting colors
Ultra lets you adjust the colors of any source in a session. For the input clip, you can make 
separate adjustments for pre-processing and post-processing. Changes made in the Pre-
Processing mode are applied to the source before being keyed and, therefore, affect what the 
keyer sees and has to work with. Post-Processing adjustments are applied after keying. If the 
color of the background is not well-saturated and, therefore, is not keying well, then you may 
want to change them in the Pre-Processing mode. If the keyed subject does not fit in well with 
the selected virtual set or requires corrections to counter pre-processing color adjustments, 
then you may want to adjust its colors in the Post-Processing mode. To select the appropriate 
mode, select its option at the top of the control area. The controls in these modes are identical 
with the exception of the Gamma slider, which is available only in the Post-Processing mode.
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For the other layers, Ultra does not perform processing like keying, so the pre-processing and 
post-processing distinction is irrelevant. You can change the colors of layers in a virtual set like 
any other source. For example, if you don’t like the Digital Studio sets in blue, you can use the 
Hue control to change the color. To access those layers, press Alt+P or choose View > 
Displayed Inputs > Pre-Defined.

Making color corrections
By default, the controls on the Colors tab are disabled. Before you can make any changes, you 
must select Enable to activate the controls. For input clips, you enable and disable the Pre-
Processing and Post-Processing controls independently. If you already changed a layer and 
want to see it in its original state, deselect Enable to disable the controls. All of the current 
settings are preserved.

The controls on the left side of the Colors tab—Brightness, Contrast, Saturation, and Hue—
are common to nearly all video and graphics editing applications.

Brightness: Brightness is the dimension of a color that represents its similarity to one of a 
series of achromatic colors ranging from very dim (dark) to very bright (dazzling).
Contrast: This control affects the tonal variations between the highlights, middle tones 
and shadows of the image. Contrast is the difference in visual properties that makes an 
object (or its representation in an image) distinguishable from other objects and the 
background.
Saturation: This control affects the intensity of a specific hue. It is based on the color's 
purity; a highly saturated hue has a vivid, intense color, while a less saturated hue appears 
more muted and grey.
Hue: This control affects the color type (such as red, blue, or yellow).

The controls on the right side of the Colors tab—Level, Offset, and Gamma—can apply to all 
color channels or to only one channel. When working with any of these controls, you must 
first select the color channel that you want to change. By default, the whole spectrum is 
selected (RGB). To select a channel, deselect the RGB check box, and then select the desired 
channel. 
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One of the main reasons you would change the colors is to give the various layers a 
comparable look and feel. You typically achieve the best results by making moderate 
changes to two or more sources rather than making more extensive changes to only one 
source. Keep in mind that achieving a good match between the keyed subject and other 
layers starts when you shoot the video for the input clip or design a custom set for it, 
whichever comes later. If you do a good job at that stage in the process, you need only 
minor color corrections in Ultra.
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Level: This control affects only pixels that have a value in the selected color channel. If, for 
example, you’re working in the red channel, pixels that have a red value are less red if you 
decrease the level and more red if you increase the level. If you’re working in the RGB 
mode rather than having a single channel selected, then the result is the same as the 
Brightness control because all three channels are adjusted together.
Offset: This slider boosts or cuts the value in the current channel regardless of whether a 
pixel had any of that color to begin with. If you select the red channel and push this value 
all the way up, pixels that were pure green (0/255/0) become pure yellow (255/255/0).
Gamma: The result of this control varies depending on the initial value in the selected 
channel. The results are most pronounced for values at the middle of the 0 to 255 range, 
and diminish for pixels at the extremes in the selected channel. At the absolute extremes, 0 
and 255, there are no changes at all. If a pixel started at chartreuse (127/255/0) and you 
change the red channel, the color changes noticeably toward a more pure green if you 
decrease the gamma and toward yellow if you increase the gamma. If you select the green 
or blue channel, then the pixel is not affected at all. Adjusting Gamma is similar to using 
the midpoint slider of the Levels control in Adobe Photoshop.

As you adjust a color slider, the results are reflected in the Input Preview Monitor and Output 
Preview Monitor and in the reference display to the right end of the Colors tab. Ultra provides 
a selection of color wheels and color bars, each of which provides a different view of the color 
spectrum and how changes affect its display. To change which one is shown in the reference 
display, select from the list above the reference display.

Saving and applying color settings
Ultra lets you save a profile of particular color settings and apply it to other sessions. You can 
also use this feature within a given session to save one or more profiles and switch between 
them to see which profile you prefer. Each profile saves the settings from the Pre-Processing 
and Post-Processing modes on the Colors tab.

To create a profile, click the Save button at the lower left of the Colors tab. A standard 
Windows Save As dialog box appears. The default path is My Documents\Adobe Ultra 
CS3\My Settings. The profile’s extension is .ccs.
To apply an existing profile to the current session, click the Load button, browse to the 
correct folder if necessary, and select the desired profile.
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Adding shadows and reflections
When done correctly, shadows and reflections provide a key finishing touch that helps sell the 
illusion, melding the subject into the scene. When absent or done poorly, they can destroy the 
compositing result. Ultra lets you generate up to three virtual shadows and a single reflection 
on the floor and two shadows on the wall. In addition, Ultra provides the power to change 
their position and appearance so that they’re always done correctly.

Creating realistic virtual shadows is not only in general much easier than trying to preserve the 
input clip’s actual shadows, but also can produce better results. For more information, see 
“Keeping the shadow in an input clip” on page 82. In addition, if keeping the real shadow is 
the only reason for using the Apply Points keying method, then choosing virtual shadows also 
frees you to use the more advanced and effective Set Key method. For more information, see 
“Multiple Key Points Method (Color Spread)” on page 80 and “Set Key” on page 78.

Enabling a shadow or reflection and making it the active one
To turn each shadow or reflection on and off independently, select its check box.

Because a single set of controls on the Shadows tab serves both effects, a particular shadow or 
reflection must be both enabled and selected as the active one before you can change it. If the 
desired effect is disabled, then enabling it also makes it the active one. If it’s already enabled, 
then you must click its name in the right column to select it as the active one. Selecting the 
check box for an effect that’s already enabled selects it as the active one, but turns it off in the 
process. If the sliders are dimmed, then the active effect is disabled.

In the following example, Shadow 1 and Shadow 3 are enabled, and Shadow 1 is active.
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Changing the position of a floor shadow
There are four controls involved in setting the position of a shadow. The following diagram 
shows the result of all of the controls. Although the process looks complex, when you take it 
step by step, the process is simple enough that you can probably learn how to position a 
shadow by loading one of the sample sessions and experimenting with the sliders.

A) Spread  B) Length  C) Angle  D) Baseline 
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To position shadows and reflections

1. Use the Baseline slider to align the bottom of the shadow or reflection with the bottom of 
the subject. Adjusting this slider moves the horizontal plane on which the shadow lies (the 
red arrow in the following diagram).

A) Baseline slider bar - Top setting  B) Baseline slider bar - Bottom setting  C) Red arrow 
indicates the baseline

2. Use the Flip Vertically option to specify if the shadow appears behind the subject or in 
front of it. With classic three-point lighting, the shadow from the back light shows in front 
of the subject.

T
IP If you're having difficulty aligning the bottom as precisely as you’d like, try changing 

the Y value for the Orientation In Scene control on the Scene tab to 89° so that the 
layer plane and the shadow plane are nearly edge-on to you. When the horizontal 
position is correct, the bottom of the subject and the end of the shadow meet along a 
line; there is no gap or overlap.
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3. Adjust the Angle slider to set the direction that the shadow extends from the subject. This 
corresponds to the angle between the line from the camera to the subject (the black line in 
the following diagram) and the angle from the light stand to the subject (the green line in 
the following diagram). Changing this setting is similar to moving the virtual light stand 
on an arc (the cyan line in the following diagram).

A) Angle slider bar - Left setting  B) Angle slider bar - Right setting  C) Angle  D) Arc

4. Adjust the Length slider to change the length of the shadow. This has the same result as 
raising or lowering the virtual light on its stand.

A) Length slider bar - High light, short shadow setting B) Length slider bar - Low light, long 
shadow setting C) Length
114 How to



5. Adjust the Spread slider to change the width of the shadow relative to the size of the source. 
This has the same result as moving the light closer or farther away along its current line (the 
yellow line in the following diagram), which in the real world involves moving the light 
stand closer or farther and adjusting its height (the orange line in the following diagram).

A) Spread

T
IP When deciding how many shadows to use and where they should fall, try to mimic the 

position of lights for the shoot. Ideally, you should design the lighting at the shoot with 
the virtual set in mind. The following graphic represents the types of shadows that you 
may expect from basic three-point lighting. Notice that the key light shadow is darker 
(that is, more opaque) than the other shadows.

A) Key light shadow  B) Fill light shadow  C) Back light shadow
Fine-tuning the appearance of the video 115



Changing the position of a wall shadow
When you select a wall shadow, a grid control replaces the set of positional sliders used for 
floor shadows. The grid control lets you adjust the shadow’s position and size. The black 
rectangle represents the edges of the scene’s visible frame.

To move the shadow right and left along the X axis, drag the grid sideways, or enter a 
value in the X field.
To move the shadow vertically along the Y axis, drag up and down, or enter a value in the 
Y field.
To shrink or enlarge the shadow, Shift-drag up or down, or enter a value in the Z field. 
Enlarging a wall shadow is similar to increasing the spread of a floor shadow in that both 
effects mimic having a light source close to the subject. Shrinking a wall shadow simulates 
increasing the distance between the subject and the wall.

Changing the appearance of a shadow or reflection
Four controls affect the appearance of a shadow or reflection. Three controls—Opacity, 
Falloff, and Falloff Edge—relate to the opacity and how much of the effect is visible. Blur 
controls how sharp the edges are.

Opacity, Falloff, and Falloff Edge

These controls interact with one another. You generally achieve the best results by changing 
them in the following order.

N
O

T
E

Subtlety is crucial when adding virtual shadows. When done well, they should be such an 
integral part of the scene that the viewer scarcely notices them. In other words, if a 
shadow or reflection draws your eye, then it may be overdone.

N
O

T
E

The controls for changing the position of a shadow or reflection work relative to the layer 
plane. Therefore, in some circumstances, the response may be the opposite of what you 
would assume. For example, if you flip the layer plane by using the Orientation In Scene 
control, then shadows appear in front of the subject, and the reflection extends behind it.

N
O

T
E

The three floor shadows have different default positions, as described by their names. 
Shadow 1 - Floor Left and Shadow 3 - Floor Right are designed to produce long 
shadows cast off behind the subject and off to the sides. Although you can move the 
shadows to exactly the same positions, Adobe recommends that you keep them in their 
native sectors if for no other reason than to know which shadow is which when you 
return to these controls later. Shadow 2 - Floor Center is designed to pool around the 
subject’s feet as if from one or more overhead lights. It is blurrier and more amorphous by 
design, and the result of the Falloff control differs from the other two shadows.
116 How to



1. Opacity controls how transparent the shadow or reflection is across its entire extent. As 
opacity increases, the color of the shadow shifts toward black.

A) Opacity slider bar - Transparent setting  B) Opacity slider bar - Opaque setting

2. Falloff applies a gradient of transparency. The shadow or reflection becomes more 
transparent with distance from the subject. To be more precise, this slider controls how far 
up the shadow the gradient is applied. Beyond a point, which varies depending on other 
settings and the nature of the background, the end of the shadow or reflection fades into 
invisibility. As this value approaches its maximum setting (1.000), the part of the effect that 
remains visible becomes shorter.

A) Falloff slider bar - No fall off  B) Falloff slider bar - Full fall off
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3. Falloff Edge stretches and compresses the Fall Off gradient. Stretching the gradient 
lengthens the distance over which the shadow or reflection drops from the baseline opacity 
(as set by the Opacity control) to full transparency. If the Fall Off setting made the end of 
the effect invisible, it may make the entire shadow visible again. Compressing the gradient 
shortens that distance over which the shadow or reflection becomes transparent. If the 
slider is all the way to the left, the falloff becomes a crisp line instead of a gradient, which 
you can use to make a shadow or reflection appear to end abruptly when it reaches an object 
in the background or foreground.

If the Falloff slider is set to either extreme (0.000 or 1.000), then the Edge Softness 
control has no impact.

A) Blur slider bar - Sharp setting  B) Blur slider bar - Fuzzy setting

Blur

The Blur slider controls how crisp the edges of the shadow or reflection are.

Saving and applying settings for a shadow or reflection
Ultra lets you save a profile of the settings for a single shadow or reflection and apply it to 
other sessions. You can also use this feature in a session to save one or more profiles and switch 
between them to see which you prefer.

To create a profile

1. Select the shadow or reflection for which you want to save a profile.

2. Click the Save button in the lower-left corner of the Shadows tab. A standard Windows 
Save As dialog box appears.

3. Change the path by using the Save In field, if desired. The default path is My Documents/
Adobe Ultra CS3/My Settings.
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4. Enter a name in the File Name field. The profile’s extension is .shw.

To apply an existing profile, select the desired shadow or reflection and then click the Load 
button, browse to the correct folder if necessary, and select the desired profile.

Defocusing a source
The depth of field, or crispness of focus, in different layers of a composited image can make a 
difference in how realistic the image looks and subtly cue the viewers as to what’s most 
important in the image. You can digitally defocus any layer in a session by selecting it to make 
it the active layer, and adjusting the Defocus slider on the Input tab.

This adjustment calls for a light touch. In the following example, the background of the 
image on the left is in crisp focus. The background of the image on the right has the Defocus 
set to 0.07, which is just enough to make the umbrella, beach chair, and waves slightly fuzzy, 
thereby accentuating the distance behind the subject.

Saving the finished video
Ultra provides several options for exporting the composited output of a session for use in 
nonlinear editors (NLEs) and other graphics and video applications. You can produce videos 
in HD and SD, you can output in 16:9 and 4:3 frame aspect ratios, and you can save out as a 
series of still images or video. In addition, you have several frame rates to choose from, with 
both progressive and interlaced options. Ultra is compatible with applications such as After 
Effects® and Adobe® Premiere® Pro, as well as other popular video editing software.
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Although you often compress your video for distribution when it’s finished, you should avoid 
uncompressing and recompressing clips as you work with them at different stages in the post-
production process, because each cycle degrades the quality of the audio and video. If you are 
working with a movie output from Ultra in an NLE or another application, Adobe 
recommends that you save the output movies uncompressed. This yields the highest quality 
video, but also the largest files. However, you’ll compress the finished product at a later time. 
To save uncompressed clips, set the format to DirectShow and set the codec to Uncompressed. 
Buttons for saving as a 24-bit or a 32-bit keyed source then appear below the codec field. 
Leave this set to 24-bit.

Lossless compression can and should be used for interchange between Ultra and non-linear 
editing systems.

To save the finished video

1. On the Output tab, select a format:

DirectShow: DirectShow is a Windows component that supports a wide variety of 
video codecs. By default, DirectShow supports several common media file formats, 
such as ASF, MPEG, AVI, MP3, and WAV sound files.
QuickTime: Apple QuickTime is a file format for a container for audio, video, and 
still-image files. To output to a QuickTime file, you must have QuickTime installed 
on your computer.
Frame Sequence: This option lets you export a separate still image for each frame in 
the session. For more information, see “Outputting still images (Frame Sequence)” 
on page 122.

2. Select a codec. The codec options that are available in this list depend on the format that 
you select and, in the case of DirectShow and QuickTime, on what codecs are installed on 
the computer.

3. Depending on which codec option you selected, the Configure button may be enabled. If 
it is, then the codec has parameters that you can customize. See the codec’s documentation 
for more information about the options in its Configuration dialog box.

4. Depending on the codec option, there may be additional options from which you can 
choose. The following are some of these options:

T
IP You should generally save output movies in the same resolution that you will use in 

the editor. One situation that can cause problems is the difference between 
720x480 and 720x486. If you use a clip that you export from Ultra at 720x480 in an 
editor that’s set to 720x486, you may have problems because some NLEs 
incorrectly stretch a 480-line video to fill 486 lines, thereby causing problems with 
the field order. While that’s clearly a problem in the NLE, not Ultra, you can avoid 
problems by exporting a session to the proper resolution.
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Uncompressed options: 24-bit (standard) or 32-bit Keyed Source (preserves alpha 
channel). For more information, see “Outputting clips or stills with an alpha channel” 
on page 122. If you select 32-bit, then you also have the option to invert the alpha 
channel for compatibility with applications that interpret alpha channels as film alpha 
(0 means opacity) instead of video alpha (0 means transparency).
DV Video Encoder: Type 1 (file containing separate streams for audio and video 
content) or Type 2 (single stream for audio and video). The most common type is 
Type 2. 
With Type 1, the multiplexed Audio-Video is kept in its original multiplexing and 
saved together into the video section of the AVI file. This method has a relatively small 
file size, but Windows applications based on the VfW API do not support it.
With Type 2, audio is saved as an additional audio stream into the file. This type is 
supported by VfW applications, and has a larger file size.

5. Select a resolution. Some codecs lock this option.

6. Select a frame rate. The frame rates that are available vary depending on whether you are 
working in NTSC mode or in PAL mode.

7. Select a field order that’s compatible with the editing application. If you’re not sure which 
field should be first, see the NLE’s documentation. Standard-definition video (such as 
NTSC DV) is typically lower-field first, whereas many high-definition formats (such as 
DVCProHD 1080i) are upper-field first.

8. Enable the Flicker Filter if the composited scene contains high-contrast thin lines or other 
patterns that may produce an unpleasant strobing effect in an interlaced video. Clothing 
with a fine pattern is known to introduce this problem.

9. Enter a name for the output movie in the File Name field.

10. If you want the output movie saved to a path other than the path shown in the Folder field, 
then click the Browse button, and set the desired path.

11. Click the Save Output button to export the video. The status bar indicates what percentage 
of the job is finished, and the Time Remaining field estimates how much longer it will take.

N
O

T
E

You may notice that one option on this control panel tab—aspect ratio—is not 
included in this sequence of steps. That’s because you should have selected 4:3 
or 16:9 when you created the session. Changing it at this point may require 
repositioning layers and reprogramming virtual camera moves.
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Outputting still images (Frame Sequence)
Ultra lets you export a session as a series of still images rather than as a video clip. Some 
advanced image compositing tools work better with this type of frame sequence than with 
video. This file format also makes the composited content available for use in standard image-
editing applications, such as Adobe Photoshop and Fireworks.

To export a series of stills, select Frame Sequence in the Format field, and then select the 
image type in the Codec field. The frame rate, field order, and resolution also apply despite 
the fact that you’re exporting stills, not video. The product of exporting in this manner is a 
series of sequentially numbered images, one for each frame. The text that you enter in the 
Image Prefix Name field appears at the beginning of each image’s file name, before the image 
number. Since a session that is only one minute in length produces well over 1,000 images, 
you may want to create a folder for each frame sequence that you export. You can do this 
through the dialog box that appears when you click the Browse button on the Output Folder.

Outputting clips or stills with an alpha channel
If you want to output a clip containing only the input clip with the subject keyed and the rest 
of the frame transparent, set the format to DirectShow AVI, set the codec to Uncompressed, 
and then select 32-bit Keyed Source. This option is also available when you export still images 
(Format = Frame Sequence) as PSD, PNG, BMP, TIFF, and so on.

When you export in 32-bit, only the input clip layer is included, and all of the settings related 
to the size, position, and orientation, both those predefined by a virtual set or user-defined by 
using the Scene, Input, and Pan & Zoom tabs are ignored. In other words, 32-bit output 
movies are 1:1 relative to the source for the input clip layer. If the Input Preview Monitor is 
1:1, then what you see is what appears in the output movie.
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5

CHAPTER 5

Troubleshooting and getting 
help
Updating software
A first step in resolving problems with software is often to ensure that you are using the most 
up-to-date software—for the application, device drivers, and the operating system.

Updating Ultra
If you are having problems with Adobe® Ultra® CS3 and are connected to the Internet, Adobe 
recommends that you ensure that you are using the most up-to-date version of Ultra software 
before you try anything else.

To check for updates, choose Help > Updates. Follow the on-screen instructions to check for 
an update and to download it if one exists.

Even if the update does not fix the problem immediately, it can improve the ability of Adobe 
technicians to isolate the problem and identify a solution.

Updating device drivers
The hardware devices attached to a computer—such as the mouse, webcam, and sound 
card—require files called device drivers that tell the operating system and other software how 
to interact with them. Often, hardware manufacturers release new drivers that can increase 
performance or fix compatibility issues.

If your devices are working with Ultra, Adobe recommends that you do not update them, 
because sometimes new drivers can cause new problems.

To get the latest drivers for devices connected to a desktop computer, go to the website of the 
device manufacturer. To get the latest drivers for devices connected to a laptop computer, it is 
sometimes better to go to the website of the laptop manufacturer.
123



If your device meets the minimum requirements, then it will probably work with Ultra. If you 
are having problems, see the Adobe Ultra Technical Support website at www.adobe.com/
support/ultra for the most up-to-date information. 

Updating the Windows® operating system
In certain situations, you may need to update the Windows operating system.

1. Open Internet Explorer.

2. Select Tools > Windows Update.

3. Follow the on-screen instructions.

Technical Support
Adobe is happy to help you identify and solve any problems that you may have using Ultra 
software.

You can save time and help us to isolate the cause of the problem by providing complete and 
accurate information about your computer system. To show a summary of some basic system 
configuration information, choose Help > About Adobe Ultra. If you are using email or the 
User Forum to get help, copy and paste this information (except for the copyright 
information) into your message. 

Also, run the DirectX Diagnostic Tool and send the results with the description of your issue.

Technical support web pages
For information on technical support, visit the Ultra support page at www.adobe.com/
support/ultra. From the support pages, you can review the latest troubleshooting tips and 
updates and access the Adobe user forums. All types of users from novices to experts access the 
user forms and provide tips and advice. If you have a question about Ultra, you’re likely to 
find an answer there.

Run the DirectX Diagnostic Tool
1. Open the DirectX Diagnostic (DxDiag) tool:

In Windows XP, choose Start > Run and type dxdiag in the Open field, and then click 
OK.
In Windows Vista, choose Start and type dxdiag in the Search text box, and press Enter.
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2. When the status bar near the lower-left corner of the dialog box disappears, click the Save 
All Information button. The Save As dialog box appears.

3. Specify a location and file name, and then click the Save button.

4. Locate and open the resulting file, and copy and paste its contents into your message.

StatusLog.txt file
To troubleshoot some problems, you may also be asked to provide Technical Support with the 
contents of the StatusLog.txt file. Each time Ultra starts, it makes a list in this file of each 
component in your system that it attempts to initialize. If startup fails when it reaches a 
particular component, the cause of the failure may be indicated by the last entry in this file. 
The problem can sometimes be resolved by updating that component’s driver.

The StatusLog.txt file is located here:

Windows XP: C:\Documents and Settings\[user name]\Local Settings\Application 
Data\Adobe\Adobe Ultra CS3
Windows Vista: C:\Users\[user name]\AppData\Local\Adobe\Adobe Ultra CS3

Symptoms and solutions

Symptom Solution

When I click the Set Key button, 
the subject becomes a ghost, 
similar to the following image:

The subject was in the frame when you clicked the Set Key 
button. To recover, either drag the preview slider to a clear 
reference frame (with only the color screen background 
showing) and click the Set Key button again, or use one of 
the Key Point methods. For more information, see “Setting 
Key Points (Apply Points Method)” on page 79.

When I play a session in the 
Output Preview Monitor or save 
an output movie, the session 
continues after the input clip 
ends.

There is a video clip in another layer that either has a longer 
overall duration than the input clip or has the Offset Into 
Scene value set so that it continues playing after the input 
clip ends. Ultra continues playing until it reaches the end of 
last clip playing.
Identify which clips continue playing after the input clip 
ends, and trim them to end at the same time as the input 
clip.
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